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In this chapter, you’ll learn how to use the Edit page to assemble new timelines from scratch and 
modify existing timelines that you’ve imported for finishing. Whether you’re using Resolve as an 
NLE to edit an entire program, as a dailies system to create quick rough assemblies for grading and 
transcoding, or as a finishing system with which to replace VFX clips, fix problems with an errant 
conform, and make last-minute re-edits to a program to be graded, the Edit page has many of 
the tools you’re accustomed to using in other editing environments, and a few that are unique to 
DaVinci Resolve. 

For more information on how to use the Edit page to import and conform projects edited in other 
applications for color correction and finishing in DaVinci Resolve, see Chapter 9, “Preparing and 
Conforming Projects.”

This chapter covers the following topics:

Edit

The Edit Page User Interface� 196

Timelines� 196

The Browser� 198

Effects Library Browsing� 202

Edit Index� 204

Source/Offline and Timeline Viewers� 206

Inspector� 209
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Navigating Using Timecode� 225
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Selecting Edits in the Timeline� 265
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Adding and Editing Transitions� 308
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Starting with Resolve 11, the Edit page has been organized into a source-record style NLE that adds 
many specialized features for finishing. The Edit page is divided into three main regions: the 
browsers found at the left, the Viewers at the top, and the Timeline at the bottom, all of which work 
together to let you import, edit, and trim timelines with a flexible variety of tools and methods.

The Edit Page in its entirety

Timelines

DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in other 
applications) which are organized in the Timelines Browser, and displayed in the Timeline editor (referred 
to as “the Timeline”). Timelines contain clips, the source media of which is kept in the Media Pool, and 
which also appear as edit events in the Edit Index that can be shown at the right of the Timeline.

Timelines, Grades, and Versions

Within any given timeline, grades are associated with the timecode of the source clip they’re 
applied to. That means that as you alter the timeline, each clip’s grade moves along with it, making 
it extremely easy to move back and forth between editing and grading as your needs require. By 
default, each timeline in a project has independent sets of grades using Local versions; this is true 
even if your timelines are duplicates. That means each clip within every timeline has a completely 
independent grade.

However, if you switch the clips in one or more timelines to use Remote versions, a clip’s grades 
are shared by every instance of that clip in all timelines with clips that also use Remote versions. If 
you import a new timeline that rearranges clips into a different order and switch it to using Remote 
versions, then grades will automatically follow the clips, so that the clips within each new timeline 
inherits the grades applied to those same clips in other timelines.

The Edit Page User Interface
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You can switch a timeline between using Local and Remote grades at any time. For more information 
on using Local versus Remote versions, see “Using Versions to Manage Grades” in Chapter 13, 
“The Gallery and Grade Management.” You can also copy grades from one timeline to another 
using the ColorTrace feature. For more information about ColorTrace, see Chapter 9, “Preparing 
and Conforming Projects.

Enabling the Use of a Master Timeline

Previous versions of Resolve had a Master Timeline, which consisted of one long timeline containing 
every clip in the Media Pool, arranged by default in ascending order by timecode. While the Master 
Timeline was useful for a variety of tasks, architectural improvements have rendered it unnecessary, 
and by default the Master Timeline does not appear in new projects created by DaVinci Resolve 
version 10 or later.

However, if you want a Master Timeline in order to have a single timeline that always contains all 
clips currently in the Media Pool, there’s a way you can create one. You need to do it immediately 
upon creating a new project, before adding any media to the Media Pool. Once you’ve added one 
or more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1. 	 Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox. If you also want all clips to 
use Remote versions as you grade by default as in previous versions of Resolve, you can turn 
off the “Store grade with local version by default.”

Turning on the option to use a Master Timeline

2. 	 Click Apply, and close the Project Settings window.

3. 	 Open the Edit page, and choose File > New Timeline.

4. 	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, 
and click Create New Timeline.

	 Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.
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	 Tip: If you want to make sure that you always have a Master Timeline when you create new 
projects, you can alter the Project Setting preset for your user account to reflect these settings, 
or you can create a new Project Setting preset with these settings that you can easily switch to.

Creating a Master Timeline

The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in 
ascending order by timecode. Each clip in the Master Timeline appears at its full duration, regardless 
of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. Whenever you 
add more clips to the Media Pool, they’re automatically added to the Master Timeline. 

The Master Timeline is useful for organizing media for which no editing has yet been done, such 
as when grading digital dailies. The Master Timeline is also useful for identifying a range of similar 
clips, based on their similar ranges of timecode. For example, you could find all the talking head 
shots from a particular section of tape clustered together in the Master Timeline.

The Browser

A unified browser lets you organize and peruse all of the timelines and media in a project. The 
Browser can be switched among two different modes, showing Timelines or the Media Pool, by 
clicking the appropriate button.

Timeline Browsing

The Timelines browser contains all timelines that have been either imported or created within that 
project. A folder view at the left shows a hierarchical list of folders that you can use to organize your 
timelines. You can create more folders by right-clicking anywhere in the empty area of the Media 
Pool and choosing Add Folder. You can rename any custom folder by double-clicking on its name 
and typing a new one, or by right-clicking a folder header and choosing Rename Folder. The folder 
view can be hidden or shown via the button at the far left of the Edit page toolbar. 
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The Timeline list

A panel to the right shows the contents of the currently selected folder. Every AAF, XML, or EDL 
file you import, and every timeline you create, appears as a new timeline in this panel. You can have 
as many timelines as you need within a single project. Since each timeline references clips in that 
project’s Media Pool, multiple timelines are often used for multiple edited versions of a particular 
program or reel. Additionally, multiple timelines can be used to create differently graded versions 
of a particular edit.

To switch timelines, do one of the following:

>> In the Edit page Media Pool, double-click a timeline in the Timeline list, or choose a timeline 
from the Timeline Viewer name pop-up menu.

>> In the Edit page Timeline Viewer, choose a timeline from the Timelines pop-up menu at the 
top of the viewer.

>> In the Color page, choose a timeline from the Timelines pop-up menu at the top of 
the viewer.

To switch timelines using the DaVinci control surface:

1. 	 Press MODES, above the fourth trackball on the Center panel.

2. 	 Press the SWITCH SESSION soft key repeatedly to switch among all available timelines in the 
Project Browser.

3. 	 Press MODES again when you’re finished.
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Media Pool Browsing

The Media Pool is displayed on both the Media and Edit pages, and shows you all of the source 
clips that are available for editing.

A folder view at the left shows a hierarchical list of folders that you can use to organize your media. 
By default, the Media Pool has a single folder, named “Master,” but you can add more folders as 
necessary to organize your clips. The folder view can be hidden or shown via the button at the far left 
of the Edit page toolbar. A panel to the right shows the contents of the currently selected folder. 

If you create multiple folders in the Media Pool, they appear as additional items in the Folder view. 
Each header has a disclosure triangle at its left that lets you show and hide the contents of 
that folder.

The Media Pool in Thumbnail mode
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You can create more folders by right-clicking anywhere in the empty area of the Media Pool and 
choosing Add Folder. You can rename any custom folder by double-clicking on its name and typing 
a new one, or by right-clicking a folder header and choosing Rename Folder. You can color code 
any folder by right-clicking it and choosing a color from the Color Tag submenu, and you can filter 
color-tagged folders using the filter pop-up at the bottom-right of the Folder view.

As in the Media page, the Media Pool can be displayed in either Icon or List view. In List view, you 
can sort the contents by any one of a subset of the total metadata that’s available in the Metadata 
Editor of the Media page. Of particular interest to editors are columns for Name, Reel Name, 
different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, Circled, 
Start KeyKode, Flags, Usage, Resolution, and Frames Per Second.

A Search field at the upper-right of the Media Pool lets you search for any clip, and a pop-up menu 
to its left lets you choose specific metadata criteria to perform a more focused search. As soon as 
you enter any text into this field, clips that don’t match are temporarily hidden. To show all clips 
again, click the cancel button at the right of the search field.

For more information on using the Media Pool, see Chapter 4, “Media.”

Taking Advantage of the Media Pool’s Usage Column

In List view, the Usage column does not automatically update to show how many times a particular 
clip has been used. However, you can manually update this metadata by right-clicking within the 
Media Pool and choosing Update Usage Data from the contextual menu that appears. Afterwards, 
each clip will display how many times it’s been used in this column. Clips that have not been used 
yet display an x.
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Effects Library Browsing

The Effects Library contains a folder with the different Video Transitions, Title Effects, Generators, 
and Filters that are available for editing in the Timeline.

Transitions

You can drag any video transition to any edit point in the Timeline that has overlapping clip handles 
to add it to your edit; you have the option to drag the transition so that it ends on, is centered on, or 
starts on the edit point. You can also use various contextual menus and keyboard shortcuts which 
are described later in this chapter.

Titles and Generators

Titles and Generators can be edited into the Timeline like any other clip. Once edited into the 
Timeline, you can open that clip into the viewer to access its controls in the Inspector, for 
customization. You can choose a standard duration for generators to appear with in the Editing 
panel of the Project Settings.

The Effects Pool, made taller to show all of its contents
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OpenFX

DaVinci Resolve supports the use of third-party OpenFX transitions and generators in the Edit 
page. Once you install these effects on your workstation, they appear in the OpenFX panel of 
the Effects Library, organized by type and group depending on the metadata within each effect. 
These transitions and generators can be used in the same way as other transitions and generators 
in Resolve.

Effects Library Favorites

You can right-click any transition, title, or generator and choose “Add to Favorites” to flag that effect 
as a favorite effect. When you do so, choosing Favorites from the Effects Library option menu filters 
out all clips that are not favorites, letting you see only effects you most commonly use.

The Effects Pool, made taller to show all of its contents
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Edit Index

Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of 
all the edit events in the current timeline. Whichever timeline is selected in the Timeline list displays 
its events here. However, the contents of the Edit Index can be filtered using commands found in 
the Option pop-up, described later in this section. 

Edit Index List shown open

Each event populates several columns of information. These columns can be rearranged by 
dragging them to the left or right, depending on what information is most important to you.
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Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show only 
the clips on the video track the intersecting clip is on, and that clip’s event is highlighted in the Edit 
Index. This makes it easy to see the correspondence between a clip in the Timeline and its event, 
which is helpful when troubleshooting problems. There are also commands available in the Option 
menu to display only clips on enabled tracks, only video clips, and only audio clips.

Each event populates several columns of information. These columns can be rearranged depending 
on what information is most important to you. The available columns of information are:

>> #: The event number (which corresponds to the clip number shown in the Thumbnail 
timeline of the Color page)

>> Reel: The reel name of the corresponding clip

>>Match: Offline clips that aren’t currently linked to source media display an X in this column. 
Indicates clips that are offline.

>> V: Video event

>> C: The event type (C for cut, D for dissolve or transition)

>> Dur: A number showing the duration of a transition in frames. 

>> Source In/Source Out: The Source In and Source Out timecode indicating the range of 
timecode referenced by that clip; corresponds to the timecode locations of each clip’s In 
and Out point relative to the source media it comes from.

>> Record In/Record Out: Record In and Record Out timecode indicating that clip’s position 
in the Timeline.

>>Name: The name of the clip.

>> Comments: Whatever comments were present in the EDL that was imported. For example, 
clip names exported from the original NLE to be used as reel names in RED workflows 
using EDL import.

>> Source Start/Source End: The very first and last frame of media available in the Source 
Media for that clip.

>> Source Duration: The duration, in timecode, of the total source media available in that clip.

>> Codec: The codec of the corresponding clip.

>> Source FPS: The frame rate of the corresponding clip.

>> Resolution: The frame size of the corresponding clip.

>> Color: The color of flags or markers applied to that clip.

>>Notes: Notes entered inside of markers applied to clips or the Timeline.
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Source/Offline and Timeline Viewers

The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. 
Meanwhile, the Timeline Viewer shows the frame at the position of the playhead in the Timeline. 
You can select either viewer by clicking, and the name of the viewer that currently has focus 
appears in orange. 

Source and Timeline viewers

Note: The Color Viewer Lookup Table options in the Look Up Tables of the Project Settings only 
affect the GUI Viewer in the Color page. They do not affect the viewers in the Edit page.

Both viewers share the following onscreen controls:

>> Zoom pop-up menu: Choosing Fit fits the currently visible frame to the available size of the 
viewer. Choosing a percentage zooms the visible frame to that size.

>> Duration field: At the top left-hand side of the Source Viewer, this displays the total duration 
of the clip, or the duration from the In to the Out point, if these have been placed. In the 
Timeline tab, this displays the total duration of the currently selected timeline.

>>Clip Name: The clip name is displayed at the center of the Source Viewer title bar. The 
Timeline Viewer displays the timeline name and is also a pop-up menu that lets you switch 
among other timelines in the current project. The clip/timeline name is highlighted orange 
when either the Source or Timeline Viewer has focus.

>> Source/Timeline Timecode Display: At the top right-hand side of the Source Viewer, this 
field shows the timecode of the current frame at the position of the playhead in the Source 
Viewer’s jog bar. In the Timeline Viewer, this field shows the record timecode of the current 
frame at the position of the playhead in the Timeline, and can be switched between source 
and record timecode by right-clicking and choosing from the contextual menu. 
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>>Option menu: The Option menu for each Viewer contains the Gang Viewers command. 
With Gang Viewers enabled, the movement of the Source and Timeline Viewer playheads is 
locked together, so that they move in unison. This is useful when you’re matching the timing 
of part of a clip in the Source Viewer to match an event in the Timeline.

>> Jog bar: In the Source Viewer, drag within the jog bar to reposition the Source playhead, 
scrubbing through the clip. In the Timeline tab, drag to reposition the playhead throughout 
the entire program.

>>Offline Mode button (Source Viewer only): If you’ve assigned an offline reference movie 
to the currently selected timeline, clicking the Offline Mode button lets you display the 
offline movie so you can compare it with the currently open timeline. In this mode, Source 
and Timeline playback are synched; an Offset field is available to resync the offline movie, 
if necessary.

>> Video button (Source Viewer only): Shows the video of the currently open clip in the 
Source Viewer.

>> Audio button (Source Viewer only): Shows the audio waveforms corresponding to all 
channels of the currently open clip in the Source Viewer. The top of this audio-only view 
shows the waveform for the entire duration of the clip, while the main region of the viewer 
shows a zoomed in section of the audio waveform. The level of zoom displayed is controlled 
by the zoom pop-up at the upper left-hand corner of the Source Viewer.

>> Transport controls: These controls include, from left to right, Jump to First Frame, Play 
Forward/Stop, Jump to Last Frame.

>>Match Frame: In the Source Viewer, Match Frame attempts to move the playhead in the 
Timeline to match the current frame of the clip in the Source Viewer. In the Record Viewer, 
Match Frame opens the Media Pool clip corresponding to the clip at the current position of 
the playhead into the Source Viewer, setting In and Out points and the playhead position 
to match those of the clip in the Timeline.

>> In/Out buttons: Places In and Out points with which to define a range of the clip, or of the 
Timeline, in preparation for making different kinds of edits.

When you turn on Offline Mode in the Source Viewer, one additional control appears that replaces 
the Duration field:

>>Offset field: Lets you specify an offset, in frames, with which to sync an offline-identified 
media clip that you’ve imported to compare to the currently selected timeline. You can 
select the number in this field in order to type a new value, or you can use the Up/Down 
arrow buttons to alter this value.
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Viewer Indicators

Certain frames trigger visible indicators in either the Source or Timeline viewers. For example, if the 
playhead is at the very first or last frame of media available to a particular clip, indicators appear in 
the lower-left or right corner of the frame to let you know there’s no more media in that direction.

If the playhead in the Timeline is on the first frame of black immediately after the last video clip 
in the Timeline, an end of sequence indicator appears in the Timeline viewer to let you know that 
you’re viewing the last frame of the current sequence of clips, even though the playhead is 
actually on a frame of black. This makes it easy to see what you’re doing while you’re first 
assembling clips together.

The end-of-sequence indicator

The first and last frame clip indicators
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Inspector

The Inspector can be opened to let you customize compositing, transform, and cropping parameters 
for clips, as well as clip-specific retime and scaling options. Furthermore, the Inspector lets you edit 
the parameters of transitions, titles, and generators used in the Timeline, in order to customize  
their effect.

The Inspector, opened and showing a clip’s parameters

When the Inspector is open, the Edit page switches to a single-viewer mode, showing you the 
Timeline item that you’re inspecting alongside the Inspector with that clip’s parameters. 

Methods of showing parameters in the Inspector:

>> To open a video or audio clip when the Inspector is closed: Select that clip, and then click 
the Inspector button at the far right of the Edit page toolbar.

>> If the Inspector is already open: You need only select a clip or effect to reveal its controls 
in the Inspector. 

>> If the Inspector is closed: Double-clicking any Transition, Title, or Generator will 
automatically open it. 

>> The Inspector shows different buttons at the top that let you switch among different pages 
of parameters. For example, when you select a clip with both audio and video components, 
the Inspector shows Video and Audio buttons at the top that let you switch among each 
set of controls. If you select a Generator effect, the Inspector only shows the controls 
corresponding to that generator.
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Timeline

The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s where 
you either edit programs together from scratch, or import sequences from other applications. For 
imported programs, the Timeline provides a visual representation of the edited program that’s 
helpful for verifying that the project was imported correctly, checking the media corresponding to 
each clip in the program, and performing simple editorial tasks necessary to prepare a project for 
grading (such as replacing or adding clips, superimposing composites, and modifying composite 
modes or transitions).

An edited timeline

>> Timeline Ruler: The Timeline Ruler shows the program’s timecode, and the playhead 
indicates the current frame of the current clip. Whichever clip intersects the playhead is 
the one that you’ll be working on in the Color page. Dragging within the Timeline Ruler 
moves the playhead. When you add markers to the timeline, these markers appear within 
the Timeline Ruler, as well.

>> Playhead: The playhead automatically syncs with the Timeline Viewer’s jog bar playhead, 
the playheads in the Mini-Timeline and Thumbnail timeline of the Color page, and the 
playhead on the Deliver page. Furthermore, the Edit Index event that corresponds to the 
clip intersecting the playhead is automatically highlighted.

>> Timecode field: Shows the current timecode value corresponding to the position of 
the playhead.

>> Video Tracks: DaVinci Resolve supports multiple video tracks. At the left of each track is a 
header area that contains a number of controls.

>> Track Header: The Track Header contains different controls for selecting, locking/unlocking, 
and enabling/disabling tracks. Each track header also lists how many clips appear on that 
track. The Track Header contains the following five controls, from left to right:
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>> Destination control: Light gray with the text of the source track that’s being assigned 
when that track is selected, dark gray when that track is not selected. The Destination 
buttons dictate into which tracks audio and video media in the Source Viewer will be 
placed when an edit is executed. Ordinarily, there is one video destination control (V1) 
and one audio destination control (A1).

>> Track Number: Each track is numbered according to its position. The bottom track is 
“Video 1,” and subsequently numbered tracks appear higher in the Timeline. Click any 
track’s number to select that track for different editing functions; the selected track is 
highlighted black.

>> Track Name: Each track has a name that defaults to the type of track and the track 
number, such as Video 1, Audio 1. However, you can double-click any track’s name 
and edit it to be whatever you like. For example, you can rename each audio track with 
the type of audio you’re editing onto it, such as Production, Ambience, SFX, or Music.

>>Number of clips: The number of clips on that particular track of the Timeline is listed 
underneath the track name.

Track Header showing the Lock Track and Enable Track buttons enabled
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>> Auto Selection button: On by default. Light gray when that track is selected, dark gray 
when that track is not selected. Turning this control on enables clips on that track to 
be included in compatible operations that depend on the position of the playhead, or 
on Timeline In and Out points.

>> Enable Track button: A slash indicates when a track is disabled. This control lets you 
turn tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, 
don’t show up in the Color page, and aren’t available for rendering or output.

>> Lock Track button: Light gray when turned on, dark gray when turned off. When a 
track is locked, clips can’t be replaced, moved, or otherwise edited, although clips on 
locked tracks can be graded.

>> Audio channel type indicator: Audio tracks also have a small indicator showing 
which channel configuration that track uses, with different icons for stereo, mono, 
5.1, and adaptive.

>> Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of video tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program. You can also navigate left 
and right using the scroll wheel of your mouse. 

>> Zoom slider: Lets you zoom into or out of the clips in the Timeline. Use the scroll wheel of your 
mouse to horizontally zoom into and out of the Timeline. Scrolling up zooms in, while scrolling 
down zooms out. You can also use Command-Plus to zoom in, and Command-Minus to zoom 
out, and Shift-Z to fit every clip in your program into the available width of the Timeline.

>> Customize Timeline pop-up menu: Four sets of controls let you customize the look of the 
clips on the tracks (filmstrip, thumbnail, or minimized), whether or not to display audio 
waveforms, whether or not to display flags and markers, and the independently adjustable 
height of the video and audio tracks.

Selecting the Timeline Viewing options
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>> Individual Timeline track resizing: Any track in the Timeline can be individually resized by 
dragging its top divider in the Track Header area.

>> Show Edit Index button: Opens and closes the Edit Index, which shows a text list of all edits 
in the Timeline, with columns for edit number, reel, cut type, duration, source and record In 
and Out points, clip name, and comments. These columns can be rearranged, depending 
on what information is most important to you. There are also commands available in the 
Option menu to display only clips on enabled tracks, only video clips, and only audio clips

>> Show Audio Meters button: Opens and closes the Edit page audio meters, which also 
contain the audio mute button. If you have a display with 2560x1440 resolution you can see 
all 16 audio meters, but on lower resolution displays only 8 audio meters appear. 

Toolbar

Eleven buttons starting from the left, running along the top of the Timeline, let you choose different 
tools for performing various editing functions.

Buttons in the Toolbar

Normal Edit Mode: The default mode in which you can move and resize clips in the Timeline, roll 
edits, and do other basic editing tasks.

>> Trim Edit Mode: In this mode, the Trim tool lets you make slip, slide, ripple and roll edits by 
dragging different parts of clips in the Timeline, or by making specific selections and using 
the “nudge” keyboard shortcuts of comma and period to move the selection left or right.
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>> Razor Edit Mode: Lets you add cuts to the Timeline by clicking.

>> Insert Edit: Performs an insert edit to the Timeline with whatever clip is in the Source Viewer.

>>Overwrite Edit: Performs an overwrite edit to the Timeline with whatever clip is in the 
Source Viewer.

>> Replace Edit: Performs a replace edit to the Timeline with whatever clip is in the Source Viewer.

>> Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.

>> Link Audio/Video: Enables or disables Audio/Video linking. When turned on, clicking a 
video clip in the Timeline automatically selects the corresponding audio clip if they’re 
linked together. When turned off, clicking a video clip won’t select its audio. Clip linking 
can be toggled while you work by pressing the Option key while clicking to make selections 
in the Timeline.

>> Loop Playback: Enables or disables looped playback. When enabled, each playback 
command loops back to the beginning when the end of that command’s range is reached. 
In and Out points in the Source or Timeline Viewers do not trigger looping. For example, 
when enabled, the Play command will play through the entire clip or timeline, and then 
loop back to the beginning when the end is reached and start playing automatically. The 
Play Around command, on the other hand, will start at the beginning of pre-roll, play 
through the post-roll, and then immediately loop back around to the beginning of pre-roll, 
continuing playback in this manner until you stop it.

>> Flag Clip/Flags pop-up menu: Flags identify clips, and indicate all clips that correspond to 
the same item of media in the Media Pool. Clips can have multiple flags. Clicking the Flag 
button automatically adds a flag to whichever clip is currently selected in the Timeline. A 
pop-up menu to the right lets you choose differently colored flags, and clear all flags from 
the currently selected clip.

>> Add Marker/Marker pop-up menu: Markers identify specific frames of individual clips. 
Clicking the Add Marker button adds a marker of the currently displayed color to the clip 
at the position of the playhead in the Timeline. A pop-up menu to the right lets you choose 
differently colored markers, and clear all markers from the currently selected clip.

These functions are described in greater detail in the following sections of this chapter.
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Navigating the Edit Page Using the Keyboard

The following keyboard shortcuts can be used to give focus to different parts of the Edit page in 
order to select bins, clips, the Source and Timeline Viewers, the Timeline, the Effects Library, Edit 
Index, and Inspector.

Dual Monitor Layout

The Edit page has a dual monitor layout that provides maximum space for the Timeline and Viewers 
on the primary monitor, and an enlarged Media Pool, simultaneously displayed Timelines browser, 
Edit Index, Effects Library, and Metadata editor on the secondary monitor.

To enter dual screen mode:

>> Choose View > User Interface Layout > Dual Screen > On.

The Edit page in dual-screen mode

Key Function

Q Toggle between Source and Timeline Viewers.

Command-1 Source Viewer

Command-2 Timeline Viewer

Command-3 Timeline

Command-4 Folder View

Command-5 Media Pool

Command-6 Effects Library

Command-7 Edit Index

Command-8 n/a

Command-9 Inspector
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To switch which UI elements appear on which monitors:

>> Choose View > User Interface Layout > Primary Display > Display 1 or Display 2, which 
reverses the contents of both monitors in dual screen mode.

Customizing the Edit page

The default layout is quite efficient for a number of tasks on most displays. You can always return to 
the default layout by choosing View > Reset UI Layout.

However, the Edit page can be customized to create more room for specific areas of the interface 
to accommodate different tasks.

To resize any area of the Edit page:

>> Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

To expand the width of the Timeline:

>> Hiding both the Edit Index and the Effects Library causes the Timeline to expand to the full 
width of your screen.

To enable a full-screen timeline in Dual Screen mode:

>> Choose View > User Interface Layout > Dual Screen > Full Screen Timeline, which causes 
the Timeline to fully occupy the primary display, while the Browser, Viewers, Audio Mixer, 
Edit Index, and Effects Library appear on the secondary display.

To open and close the Edit Index List and Effects Library:

>> Click the Edit Index button in the group at the bottom left of the Edit page.

To open and close the Inspector:

>> Click the Inspector button at the far right of the toolbar.
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To customize the columns in the Edit Index:

>> To show or hide columns in the Edit Index: Right-click any column header, and choose the 
column you want to show or hide from the contextual menu. Checked columns are shown, 
unchecked columns are hidden.

>> To resize any column of the Edit Index: Move your pointer over the divider between any two 
columns and drag when the horizontal resize cursor appears.

>> To sort the Edit list by any column: Click the Option button at the top right to display all 
active tracks, just the video, or just the audio tracks.

To show and hide the Audio Meters:

>> Click the Audio Meter button in the group at the bottom right of the Timeline.

Undo and Redo in the Edit Page

The Edit page has its own multiple-undo stack, which is separate from the multiple-undo stacks of 
each clip in the Color page. The Edit page undo commands have been separated to make it easy 
and reliable to undo edits and other changes you make in the Timeline without disturbing your work 
in the Color page. 

To undo and redo:

>> Press Command-Z to Undo, and Shift-Command-Z to Redo.

Note: Each timeline has its own undo stack.
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If you’re not importing a project that’s been edited elsewhere, you can create a new timeline to cut 
together a new edit from scratch, or to grade a set of dailies. When you create a new timeline, you 
can either create a timeline that contains all clips found in the Media Pool to quickly create a big 
batch of offline dailies, or an empty timeline that’s ready for you to add specific clips to.

Creating Blank Timelines

If you’re cutting a new program, you’ll want a blank timeline. However, it’s often useful to create 
blank timelines when putting together dailies. For example, you could create an empty timeline, 
sort the Media Pool by reel name, and add all clips from a particular reel to a dedicated timeline.

To create a blank timeline:

1.	 Select or create a Folder in the Folder View in which to put the new timeline (optional).

2.	 Do one of the following:

>> Choose File > New Timeline.

>> Right-click within the Timeline list of the Edit page, and choose Create New Timeline.

3.	 When the New Timeline Options window opens, set the following options:

>> Start Timecode: You can change the Start Timecode if a specific start time is required.

>> Timeline Name: Enter a name into the Timeline Name field.

>> Empty Timeline: By default a new timeline will be empty. If you turn off the Empty Timeline 
checkbox, the new timeline that’s created will contain all the media found within the 
Media Pool.

>> Use Selected Mark In/Out: If you’ve selected one or more clips in the Media Pool, turning 
this checkbox on creates a new timeline and automatically populates it with the selected 
clips. Clips are edited according to the sort order of the Media Pool, and each clip’s duration 
matches that defined by the In and Out points of each clip.

4.	 Click OK.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter an 
edit or create an alternate grade. 

To duplicate a timeline:

Right-click the sequence you want to duplicate in the Timeline list and choose Duplicate Timeline 
from the contextual menu. A new timeline will appear in the list with “copy” appended to the name.

Creating and Duplicating Timelines
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Creating Timelines From Bins and Selections

The “Create Timeline Using Bin” and “Create Timeline Using Selected Clips” commands let you 
quickly assemble a timeline using the contents of the Media Pool, using whatever In and Out points 
have been added to each clip, and using the sort order of the enclosing bin to determine the order 
in which the clips will be assembled.

Tip: These commands are especially useful for putting together quick assembly edits if you have 
metadata-rich media with scene, shot, and take information that you can use to sort clips into the 
proper order, and In and Out points that you’ve already logged.

To create a timeline using the full contents of a bin:

1.	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, 
and sort the Media Pool by the column that will put all clips in the order you want them to 
be assembled.

2.	 Right-click the bin in the Folder View, and choose “Create Timeline Using Bin.”

3.	 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use 
the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click 
Create New Timeline.

To create a timeline using manually selected clips:

1.	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, 
and sort the Media Pool by the column that will put all clips in the order you want them to be 
assembled.

2.	 Select one or more clips you want to assemble into a new timeline.

3.	 Right-click one of the selected clips, and choose “Create Timeline Using Selected Clips.”

4.	 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use 
the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click 
Create New Timeline.
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The following procedures show how to select one or more clips in the Media Pool to accomplish 
various editing tasks, either by opening a clip in the the Source Viewer, or selecting a group of clips 
with which you want to do drag and drop editing. This section starts by presenting different ways 
you can browse the contents of the Media Pool to find clips you want to use, in preparation for 
making a selection for your next operation.

Methods of browsing clips in the Media Pool:

>> Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer over a 
thumbnail to scrub though its contents.

Thumbnail hover scrubbing

>> Using the Media Pool Filmstrip in the Media Pool’s List view: Select a clip to expose it in the 
Filmstrip at the top of the Media Pool, and drag the pointer through the Filmstrip to watch 
it play. At any time, you can double-click a clip in the Filmstrip to open it into the 
Source Viewer.

Using the Filmstrip when the Media Pool is in List view

Tip: When browsing media, you can open clips you want to have a closer look at in the Source 
Viewer by double-clicking them in the Media Pool. Meanwhile, you can continue to open other clips 
in the Filmstrip with a single clip in order to compare different clips with your main selection that 
remains in the Viewer.

Selecting Clips in the Media Pool to Edit
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Methods of selecting clips in the Media Pool:

>> To select a single clip using the mouse: Click a clip in the Media Pool with the mouse. 

>> To select a single clip using the keyboard: Use the Arrow keys to change the selection from 
clip to clip in the Media Pool, up, down, left, and right. If you’ve selected a folder, use the 
left arrow key to close the folder, and the right arrow key to open the folder. Once a clip 
is selected, you can press an edit keyboard shortcut to edit the selected Media Pool clip 
straight to the currently open timeline.

>> To select a contiguous range of clips: In Icon mode, drag a selection box over all the clips 
you want to select. In Icon or List mode, select the first clip in a series, then Shift-click the 
last clip to select those clips and everything in between.

Selecting a contiguous range of clips

>> To select a noncontiguous range of clips: Command-click each clip you want to include in 
the selection.

Selecting a discontiguous range of clips

>> To select all clips in the Media Pool: Make sure the Media Pool has focus, then press 
Command-A to select all clips.

Once you’ve opened a clip into the Source Viewer, you can use the transport controls to play through it.
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Once you’ve decided which clips you want to use in your program, you can open them into the 
Source Viewer to review them more completely.

To open a clip into the Source Viewer using the mouse:

>> Double-click any clip in the Media Pool, or in the Filmstrip of the Media Pool, to open it into 
the Source Viewer.

To open a clip into the Source Viewer using the keyboard:

1.	 If necessary, press Command-4 to select the Folder List, and press the Up and Down arrows to 
choose a folder to view its contents. Press the Right Arrow key to open folders and show any 
nested folders within, or the Left Arrow key to close folders and hide their nested contents. 

2.	 Press Command-5 to select the Media Pool browser, and use the Arrow keys to change the 
selection from clip to clip in the Media Pool, up, down, left, and right. 

3.	 When the clip you want is highlighted, press Return to open it into the Source Viewer.

Transport Controls

The Edit page has two viewers. The left viewer, when you’re editing, should be set to show either 
source video or source audio, so it shows the source clip in any edit you’re setting up. At right is the 
Timeline Viewer, that shows the frame at the current position of the playhead in the Timeline. Using 
the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the viewers. 

Monitoring With An External Video Display

While working in the Edit page, the image that’s displayed on an external video display (if one is 
connected) is determined either by the current selection in the Media Pool, or by which part of the 
Edit page interface has focus. For example, if you select a clip in the Media Pool so it’s displayed 
within the Filmstrip, that clip is output to video. If you then open it into the Source Viewer, then the 
contents of the Source Viewer are output to video. If you switch to the Timeline Viewer, then your 
timeline is output to video.

The transport controls at the bottom of the Source Viewer

Transport Controls and Timeline Navigation
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A jog bar appears directly underneath the image, letting you drag the playhead directly with the 
pointer. The full width of the Source Viewer’s jog bar represents the full duration of a clip, while the 
full width of the Timeline Viewer’s jog bar represents the full duration of the current timeline. The 
current position of each playhead is shown in the timecode field at the upper right-hand corner of 
each viewer.

Transport controls appear underneath the jog bar. In the Source Viewer, these controls let you 
Jump to the First Frame, Play Forward/Stop, and Jump to the Last Frame. In the Timeline Viewer, 
these control move to the Previous Edit, Play Forward/Stop, and move to the Next Edit.

Simple Keyboard Shortcuts for Playback and Navigation

There are many different keyboard shortcuts you can use to simply navigate clips and timelines, and 
control playback.

>> Spacebar: You can use the spacebar to start and stop playback.

>> Step Forward/Step Back: The Left Arrow and Right Arrow keys move back and forth one 
frame at a time, while Shift-Left Arrow and Shift-Right Arrow move the playhead in one 
second increments.

>>Next Edit/Previous Edit: Up Arrow moves the playhead to the previous edit and selects 
the edit point, while Down Arrow moves the playhead to the next edit and selects the 
edit point.

>> First and Last Frame of the Current Clip: The Semicolon key moves the playhead to the first 
frame of the clip intersecting the playhead, while the Apostrophe key moves the playhead 
to the last frame of the clip intersecting the playhead.

>> Previous Keyframe/Next Keyframe: Shift-Semicolon moves the playhead to the next 
previous keyframe on the left when keyframes are displayed in the Timeline, while Shift-
Apostrophe moves the playhead to the next keyframe to the right.

>> Timeline Start/Timeline End: The Home key moves the playhead to the first frame of the 
Timeline, while the End key moves the playhead to the last frame of the Timeline.

>> In Point/Out Point: Shift-I moves the playhead to the In point set in either the viewer or the 
Timeline. Shift-O moves the playhead to the Out point.

Tip: One of the General Options in the Project Settings window, “Always highlight current clip in 
the media pool,” lets you decide whether the current selection in the Timeline is mirrored in the 
Media Pool.
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Using JKL to Control Playback

The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a list 
of the many different ways you can use these three keyboard shortcuts to play through clips and 
timelines as you work.

Once you learn all the different methods of JKL playback, they will probably become one of the 
main ways you move the playhead around in Resolve.

Special-Purpose Playback Commands

In addition to the standard transport controls, there are some additional playback controls, available 
via keyboard shortcuts or the Playback menu, that let you perform different playback operations.

>> Loop: Command-Forward Slash (/). Toggles looped playback off and on. While looped 
playback is on, playback initiated with any of the following commands will loop automatically 
until you stop playback.

>> Play around current frame: Forward Slash (/). Plays a section of the Timeline from x frames 
before to y frames after the current position of the playhead. This command is useful for 
previewing how edits play within the context of the clips immediately surrounding them. 
The pre-roll and post-roll time is customizable in the Editing panel of the Project Settings.
The pre and post roll duration of this preview can be customized in Project setting, editing.

Key Function

J Plays 100% backward.

K Stops playback.

L Plays 100% forward

Press J repeatedly Increases backward play speed each time you press 
J, for a range of fast-reverse speeds.

Press L repeatedly Increases forward play speed each time you press 
L, for a range of fast-forward speeds.

Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.

K+J Plays backward at slow motion.

K+L Plays forward at slow motion.

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

Command-JKL

Holding the Command key down while using the JKL keyboard 
shortcuts lets you dynamically resize or trim selected edit points or 
clips, depending on whether the Selection or Trim tool is enabled. 

More information on dynamic trimming appears later in this chapter.
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>> Play around current clip: (no default key assigned). Plays a section of the Timeline from x 
frames before to y frames after the current clip intersecting the position of the playhead. 
The pre-roll and post-roll time is customizable in the Editing panel of the Project Settings.

>> Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with 
In and Out points, this command lets you preview how it will play.

>> Play to In: (no default key assigned). Initiates playback and stops at the current In point.

>> Play to Out: Option-Command-Option-Forward Slash (/). Initiates playback and stops at 
the current Out point.

>> Play Around In: Option-Space. Plays a section of the Timeline from x frames before to y 
frames after the current assigned In point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the 
Project Settings.

>> Play Around Out: Shift-Space. Plays a section of the Timeline from x frames before to y 
frames after the current assigned Out point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the 
Project Settings.

Enabling and Disabling Audio Scrubbing

Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead 
with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can 
also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

>> Choose Edit > Audio Scrubbing (Shift-S)

Navigating Using Timecode

You can use absolute or relative timecode entry to either move the playhead in both the Source and 
Timeline viewers, or to move or trim selected edit points or clips. When navigating the Timeline, 
timecode entry lets you move the playhead very precisely, or jump to specific timecode values 
really quickly.

When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. Press the Return key to execute the 
timecode command. 

The rules for timecode entry are as follows:

>> The right-most pair of timecode values (or period) you enter is always the frame number.

>> A period to the left of any number you type is considered to be a pair of zeroes. A single 
period between two numbers is considered to either be a single zero, or ignored if it’s 
between two pairs of numbers.
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>> Any untyped pairs of values to the left of what you enter are assumed to be whatever those 
values were prior to the timecode you entered; this makes it easy to type partial timecode 
values even when the Timeline starts at hour one. 

It’s not necessary to enter colons or semicolons. Simple In and Out points let you join the audio and 
video of two clips at a single edit point in the Timeline. However, setting split In or Out points sets 
you up to create split edits where the video is offset from the audio in a single step.

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit 
points are selected when you press the Return key, the playhead will move to that timecode value. 
If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode 
value, if possible.

Here are some examples of absolute timecode entry using this method:

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from 
the current timecode value.

Here are two examples of relative timecode entry:

	 +20.		  00:00:20:00 is added to the current timecode value.

	 -5		  00:00:00:05 is subtracted from the current timecode value.

Gang Viewers (Playhead Ganging)

Ordinarily, the playhead movement in the Source and Timeline Viewers is independent. However, if 
you click the Option menu at the upper right-hand corner of either Viewer and turn Gang Viewers 
on, the movement of the Source and Timeline Viewer playheads is locked together, so that they 
move in unison. 

This is useful when you’re marking the In and Out points of a clip in the Source Viewer to match the 
duration of a clip or other event in the Timeline.

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:00:01:02

01:10:10:10 115.. 01:15:00:00

01:10:10:10 23... 23:00:00:00
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Now that you’ve used playback commands to review your clips, you can place In and Out points to 
set the range of each clip that you want to edit into the Timeline. If you don’t set In or Out points, 
then the entire clip will be edited into the Timeline.

To set In and Out points using the Media Pool list view Filmstrip: 

>> Set the Media Pool to List view, then select a clip to expose it in the Filmstrip at the top of 
the Media Pool, drag the pointer through the Filmstrip to watch it play, and press I and O 
to set In and Out points to the appropriate range.

The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. Once 
you’ve marked In and Out points in the Filmstrip, you can drag them to the left and right to 
move them.

To set In and Out points in the Source Viewer:

1.	 Open a clip in the Source Viewer, or select the Timeline Viewer. 

2.	 Use keyboard shortcuts, the transport controls, or jog bar to move the playhead to where you 
want to set an In or Out point. 

3.	 Do one of the following: 

>> To mark simple In and Out points: Use the In and Out buttons to the right of the transport 
controls, or press the I or O keys.

>> To mark split In and Out points in preparation for making a split edit: Right-click the Jog Bar 
and choose Mark Split > Video/Audio In/Out.

Setting In and Out Points

Marking In and Out points in the Filmstrip of the Media Pool in List view
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Simple In and Out points let you join the audio and video of two clips at a single edit point in the 
Timeline. However, setting split In or Out points sets you up to create split edits where the video is 
offset from the audio in a single step.

To clear In and Out points:

>> To clear In or Out points: With the Source Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

>> To clear both the In and Out points at once: With the Source Viewer selected, press Option-X.

To jump the playhead to the current In or Out points: 

>> Press Shift-I to move the playhead to the current In point, 

>> Press Shift-O to move the playhead to the current Out point.

Once set, In and Out points remain in place within each source clip until you set new ones.

Marking In and Out points in the Source Viewer, both as simple and split edits
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Before you start editing clips into the Timeline, it’s a good idea to understand how to customize the 
Timeline’s view in different ways. Adding, rearranging, and removing tracks, zooming in and out, 
and scrolling around the Timeline are important to working efficiently.

Creating, Deleting, and Moving Timeline Tracks

When you’re getting ready to edit clips into the Timeline, you need to make sure you’ve got enough 
tracks to do the job. The following procedures cover the different methods available for adding, 
removing, and rearranging tracks as you work.

Methods for adding, deleting, and rearranging tracks:

>> To add a track to the Timeline: Right-click on the left of the Timeline and choose Add Track. 

>> To delete a track from the Timeline: Right-click on the left of the track and choose Remove  
Track. If there are clips on a track you remove, they are deleted from the Timeline.

>> To move tracks and the clips on them up and down: Right-click on the left of the track and 
choose Move Track Up or Move Track Down from the contextual menu. That track, along 
with all clips on it, will be moved up or down relative to the other tracks in the Timeline.

Using Snapping and Zooming

When preparing to make an edit into the Timeline, you can set the snapping and zoom controls to 
whichever state is most useful for the operation you need to perform. For example, if you’re editing 
an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in to better see 
the exact place where you want to place the incoming clip. Since there are many edits at that point, 
disabling snapping might make it useful to avoid having the clip jump to the nearest edit point if you 
need to move the incoming clip to a very specific frame.

Playhead Snapping and Timeline Zoom:

>> To turn clip and playhead snapping on and off: Click the Snapping button in the toolbar, or 
press N. When snapping is turned on, the In and Out points and markers of clips all snap to 
one another and to the playhead. You can also press N to turn snapping on or off while 
dragging a clip in the Timeline.

The snapping button in the toolbar

>> To zoom into and out of the Timeline: Drag the zoom slider to the left to zoom out, and 
right to zoom in. You can also press Command-Minus (–) and Command-Equal (=) to zoom 
out and in. Either way, zooming is always centered on the current position of the playhead, 
even if the playhead is off screen.

>> To frame every clip into the width of the Timeline: Press Shift-Z.

Working With the Timeline
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Scrolling Through the Timeline 

When you’re zoomed into the Timeline, you can scroll left and right, or up and down, using horizontal 
and vertical scroll bars. You can also scroll through the Timeline using the scroll wheel of your mouse.

If you need to see more of the video or audio tracks in the available area of the Timeline, you can 
drag the horizontal divider that separates the audio and video tracks up or down to create room 
where you need it.

Dragging the Timeline center divider to make more room for audio or video tracks

Timeline View Options

As you’re working on an edit, it can often be useful to modify the appearance of the Timeline, 
changing the height of video or audio clips, choosing whether audio waveforms are drawn or not, 
etcetera. Using the Timeline View Options pop-up at the bottom right of the Timeline, you can 
make these kinds of changes as you work.

The Timeline View Options pop-up
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You have the following options:

>> Track appearance buttons: Four buttons let you choose the overall appearance of video 
and audio tracks. From left to right, the options are: Small Video Filmstrips with Large 
Audio tracks, Large Video Filmstrips with Small Audio tracks, Video tracks with thumbnails, 
Minimized tracks with no filmstrip or thumbnail.

>> Audio Waveform display checkbox: Lets you turn audio waveform viewing off and on.

>> Flags and Pins checkbox: Lets you turn the drawing of Flags and Markers off and on.

>> Video track height slider: Lets you resize the size of all video tracks at once, independently 
of the audio tracks.

>> Video track height slider: Lets you resize the size of all video tracks at once, independently 
of the audio tracks.

>> Audio track height slider: Lets you resize the size of all audio tracks at once, independently 
of the video tracks.

In addition, any track in the Timeline can be individually resized by dragging its top divider in the 
Track Header area.
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Once you’ve selected a clip to edit, marked In and Out points, and set up the Timeline for editing, 
it’s time to begin assembling your edited program together.

Drag and Drop Editing

The simplest method of editing is to drag clips from the Media Pool and drop them into the Timeline. 
You can do this with individual clips, or with selected groups of clips.

1.	 If you need to edit more specific ranges of the clips you’re editing, you can set In and Out 
points in source clips first by doing one of the following:

>> Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to List 
view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the 
pointer through the Filmstrip to watch it play and press I and O to set In and Out points to 
the appropriate range. The Filmstrip will dim the heads and tails to let you see the range of 
media you’ve marked.

>> Using the Source Viewer: Open a clip in the viewer by double-clicking it in the Media Pool, or 
selecting it in the Media Pool and pressing the Return key. Then use the transport controls, 
jog bar, or control surface buttons to move the playhead, and place In and Out points using 
the In and Out buttons to the right of the transport controls, or by pressing the I or O keys.

2. 	 If you want to edit several clips at once, select them in the Media Pool after you’ve finished 
setting In and Out points.

3.	 Drag the clip in the filmstrip of the Media Pool’s list view, the clip in the viewer, or any selected 
clips in the Media Pool, to the desired position in the Timeline to perform an overwrite edit. 
This replaces whatever was there before. Multiple clips dragged from the Media Pool will be 
edited in the order in which they’re sorted in the Media Pool, using each clip’s In and 
Out points.

Dragging a clip into the Timeline

Assembling Clips in the Timeline
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Appending Clips to the End of the Timeline

If you simply need to add one or more clips to the end of the currently open timeline, you can also 
use the Append Edit command, available from the Media Pool contextual menu.

To append one or more clips to the end of a track:

1.	 Select one or more clips in the Media Pool, or open a clip into the Source Viewer. If necessary, 
set In and Out points for the clip(s) you want to append.

2.	 Drag the video and audio destination controls to the tracks you want to append the video and 
audio of the incoming clip(s) to.

3.	 To perform the edit, do one of the following:

>> Choose Edit > Insert/Overwrite Action > Append at End

>> Press Shift-F12

>> Right-click one or more selected clips in the Media Pool, and choose “Append Selected 
Clips to Timeline.”

	 The selected clip(s) are appended as the very last clip on the destination track.
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A more controlled form of editing is to use three and four point editing to make a specific range of 
source media fit into a specific range of the Timeline. 

Setting Destination Controls to Choose a Track to Edit Onto

The destination controls, found in the Timeline header area, let you specify which video and audio 
tracks you want incoming source clips to be edited to when you use editing methods other then 
drag and drop. No matter how many video or audio channels may be embedded within a single 
clip of media, only one video and one audio destination control is available. In the case of video, 
you can only expose one video channel of a clip at a time. In the case of audio, all audio channels 
for a given clip are embedded within a single Timeline track, making it a snap to edit stereo or 
other multi-channel audio sources together. (For more information about working with audio, see 
Chapter 8, “Working with Audio.”)

Setting the destination control of a track is a vital step in the process of creating an edit, and is easy 
to do. You can set the video and audio destination controls to be separate tracks.

To set the destination tracks of incoming source clips, do one of the following:

>> Click the destination control of any unassigned track to enable that track as the destination.

>> Drag the destination control to any unassigned track in the Timeline.

>> Press Option-1 through 8 to set a video destination, or press Option-Command-1 through 
8 to set an audio destination on tracks 1 through 8.

Source/Record Editing

Selecting the Offline video to link to the current timeline
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You can also disable the video or audio destination controls in situations where you want to edit a 
source video clip into the Timeline without its audio, or vice versa. 

To disable or reenable a destination control, do one of the following:

>> Click an already assigned destination control to toggle it off and then on again. Disabled 
destination controls are highlighted red.

A disabled destination control

Setting In and Out Points in the Timeline

When you’re setting up an edit to the Timeline, you can often get away with simply putting the 
Timeline playhead at the frame where you want to edit the incoming source clip. In the absence of 
In or Out points, the playhead is used as the In point. However, you can set up different kinds of 
edits by setting specific In and Out points to define different ranges of the Timeline.

Methods of setting and clearing In and Out points in the Timeline:

>> To set an In or Out point: Select the Timeline or Timeline Viewer by clicking or pressing 
the Q key, then use the transport controls, jog bar, or control surface buttons to move the 
playhead, and press the I key to set an In point, or the O key to set an Out point.

>> To clear In or Out points: With the Timeline Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

>> To clear both the In and Out points at once: Press Option-X.

>> To jump the playhead to the current In or Out points: Press Shift-I to immediately move the 
playhead to the current In point, or Shift-O to move the playhead to the current Out point.
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In and Out points shown in the Timeline, with unmarked areas outside the selection dimmed

Methods of moving In and Out points in the Timeline:

>> Press the I or O keys at any time to change the In or Out points.

>> Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is dimmed, 
to call attention to the portion of the Timeline that will be affected by the next edit you’ll make.

Mark Clip and Mark Current Selection

These commands are automatic ways of setting In and Out points in the Timeline both at once, using 
the timing of other clips. They’re both exceptionally handy for defining the range of an incoming 
edit using clips that are already in the Timeline that you want to replace, or gaps in the Timeline that 
you want to fill. 

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to automatically 
set Timeline In and Out points for editing. For example, if there’s a shot in an edit that you want to 
replace with a different take of the same action, or there’s a gap in a sequence of clips that you’d 
like to quickly fill with b-roll, you can use the Mark Clip command to help set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to automatically 
set Timeline In and Out points for editing. A good example is when you have a series of clips in the 
Timeline, all of which you’d like to overwrite with a single incoming source clip, you can use the Mark 
Current Selection command.
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To use Mark Clip:

1.	 Move the playhead to intersect either a clip you want to use to set In and Out points, or a gap 
(empty area) between two other clips that you want to target. The playhead can be on any 
frame of this clip, it doesn’t matter which.

Positioning the playhead at a clip you want to mark 

2.	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target to set the In and 
Out points. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

3.	 Press the X key to automatically set In and Out points that match the first and last frames of the 
target clip.

Using Mark clip to set In and Out points that match a clip’s duration

	 Tip: To clear both In and Out points, press Option-X, which is the opposite of this command.
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To use Mark Selection:

1.	 Select one or more clips in the Timeline.

Selecting clips you want to use as a range to mark In and Out points

2.	 Press Shift-A to automatically set In and Out points that match the first and last frames of 
the selection. A range of discontinuous clips will produce the same result as a range of 
continuous clips.

Marking a selection to set In and Out points
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Assembling a Simple Sequence of Clips Using Overwrite Edits

Overwrite edits are by far the most common type of edit in most projects. They’re flexible in that 
you can eliminate unwanted material in other clips while at the same time adding new clips to the 
Timeline. The following example shows how you can use the Edit page to assemble a quick first cut 
of edits using different features of the Media Pool, Viewers, and Timeline.

1. 	 Open a clip into the Source Viewer, and set In and Out points to define the section of that clip 
you want to edit into your program.

2. 	 Click the destination control of the Timeline tracks you want to edit the incoming media onto. 
By default, the destination controls are assigned to tracks V1 and A1.

3. 	 To perform the edit, do one of the following:

>> Drag the clip from the Source Viewer to Timeline Viewer and drop it on the Overwrite overlay.

>> Click the Overwrite Clip button at the middle of the Toolbar.

>> Choose Edit > Insert/Overwrite Action > Overwrite.

>> Press F10.

	 The selected clip(s) are overwritten to the selected track at the position of the playhead, 
and the playhead automatically moves to the end of the newly edited clip, ready for you to 
perform another edit. If that clip is the last one on the Timeline, you’ll see the last frame to the 
left of the playhead instead of the black that is the actual frame after that clip to make it easier 
for you to line up the next edit. Otherwise, the playhead will show whatever frame happens 
to be at that point in time.

4. 	 Open the next clip you want to edit into the viewer, set In and Out points, and use the Overwrite 
Clip button or command to edit it into the Timeline. Continue this process until you’ve edited 
together the assembly of edits you want.
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Three-point editing is a standard editorial method that’s shared with many other postproduction 
applications, so this procedure should feel familiar. The idea is that you need only set any 
combination of three In and Out points in the source clip and Timeline to edit a clip into your 
program at a specific time. Three-point editing is most commonly accomplished using Overwrite 
and Place-On-Top edits.

In the previous example of assembling a simple sequence of clips, three point editing was being used 
by virtue of source In and Out points being set to define a range of the source clip to be edited into the 
Timeline, and the Timeline playhead being used as the acting Timeline In point; three points defined the 
edit to be made. However, three point editing is also very useful when you need to overwrite sections 
of a previously edited timeline with new source clips in a controlled manner, such as when adding an 
insert shot to a scene to cover a particular change you’re making that would break continuity.

Depending on the combination of Source and Timeline In and Out points you set, the following 
rules govern three-point editing:

>> If there is no In point in the source clip: The first frame of media will be used as the acting 
source In point.

>> If there is no Out point in the source clip: The last frame of media will used as the acting 
source Out point.

>> If there are no In or Out points in the Timeline: The playhead will be used as the acting 
Timeline In point.

>> If you set a Timeline In point but no Timeline Out point: The whole range from the In to Out 
points of the source clip is edited into the Timeline such that the Source In point is aligned 
with the Timeline In point.

>> If you set a Timeline Out point but no Timeline In point: The incoming source clip will be 
backtimed so the Out point of the source clip is aligned with the Timeline Out point.

>> If you set Timeline In and Out points but only a Source Out point: In this case, the incoming 
source clip will also be backtimed so the Out point of the source clip is aligned with the 
Timeline Out point, with the Timeline edit points defining the duration of the source clip 
being edited.

>> If you set all four Source In and Out and Timeline In and Out edit points: The Timeline edit 
points dictate the duration of source clip that is edited into the Timeline, and the frame at 
the Source In point is aligned with the Timeline In point.

Tip: If you want to use all four Source and Timeline edit points to retime a source clip to fit into a 
specific range of the Timeline, use a Fit-to-Fill edit instead of an Overwrite edit.

The following sections provide common examples of three-point editing when performing edits in 
the middle of a previously edited timeline.

Three-Point Editing
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Editing Rules for Split In and Out Points

If you’ve created split In and Out points in the Source Viewer or Timeline, the following rules apply:

>> If the Source Viewer has split In and Out Points: The leftmost split point of the incoming clip, 
whether video or audio, will be aligned with the playhead when the clip is edited; the other 
split point will be offset to the right.

>> If the Timeline has split In and Out Points: The In point of the incoming clip will be aligned 
with the left-most split point, whether video or audio; the accompanying audio or video In 
point will be offset to the split point to the right.

Editing a Specific Range of the Source Clip Into the Timeline

This section provides some common examples of three-point editing when performing edits in the 
middle of a previously edited timeline. In the following example, you have a specific range of source 
media that you need to edit into the Timeline, and you don’t particularly care what gets overwritten 
in the Timeline by the incoming clip.

1.	 Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

Setting source clip In and Out points

2.	 To set where you want the incoming clip to go, set the destination control to the tracks you 
want to edit onto, and then do one of the following:

>>Move the Timeline playhead to the frame you want to use as the Timeline In point for the edit.

>> Set a Timeline In point for the edit.
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Setting a Timeline In point

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

The resulting edit; the duration of the source clip defines the duration of the edit

Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline

In this example, you have a section of a clip or a gap in the edited sequence of clips in the Timeline 
that you want to fill with as much of the current source clip as it will take to “plug the hole.”

1.	 Set an In point in the source clip, if necessary, to define the first frame of the range of source 
media that you want to edit into the Timeline.
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2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

Setting both In and Out points of the Timeline for a gap

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Setting a source clip In point only
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Backtiming a Source Clip When Editing Into the Timeline

In this last example, you’ve got a specific moment in the second half of a source clip that you need 
to align with an Out point in the Timeline, such that the remaining duration of the incoming clip 
overwrites the edited sequence of clips from the right to the left. This is referred to as backtiming, 
when you’re lining up a Source Out point with a Timeline Out point in order to make an edit, and 
can be set up one of two ways.

Backtiming method one:

1.	 Set In and Out points in the source clip, either in the Media Pool or in the Source Viewer.

2. 	 Set an Out point in the Timeline, at the frame where you want the corresponding Out point of 
the incoming source clip to be aligned.

Setting up a backtimed match-on-action edit via In and Out points in the Source Viewer, and an Out point in the Timeline

The resulting edit; the duration of the Timeline edit points define how much of the source clip is edited
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3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline

Backtiming method two:

1.	 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

Backtiming method two:

1.	 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

Setting up a backtimed edit by setting an Out point in the Source Viewer, and In and Out points  

in the Timeline to define the duration of the edit
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3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline
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This section covers the different types of edits that are available for cutting source clips into the 
currently open Timeline.

Overwrite Edits

The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in the 
Timeline previously with the incoming source clip taking the place of whatever was there. Overwrite 
edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1.	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2.	 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3.	 Select a single clip in the Media Pool to open it into the Source Viewer, then set In and Out 
points to define the range of media you want to insert.

4.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto either the Overwrite overlay in the Timeline Viewer, or onto any area of the Timeline 
Viewer outside the editing overlays.

The selected clips in the Media Pool are overwrite edited to the selected track starting at the 
position of the playhead, eliminating whatever was there originally while adding incoming clip. No 
other clips are rippled during this operation.

Different Types of Edits

Before and after an overwrite edit, the Timeline duration stays the same



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

252

EDIT6

Insert Edits

An insert edit splits whatever media is already in the Timeline at the position of the playhead, and 
pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the 
Insert Edit point you’re making, pushing them further to the right by the duration of the incoming 
source clip. However, clips in any tracks of the Timeline that overlap to the left of the Insert Edit 
point aren’t rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and A1 
of the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the left of 
the insert edit point, the music clip remains where it is, but the other clips on track V1 and A1 that 
are to the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1.	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2.	 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3.	 If necessary, set In and Out points in the clip or clips you want to insert edit into the Timeline 
using the controls of the Media Pool or the Source Viewer.	

4.	 Do one of the following:

>> Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
“Insert Selected Clips to Timeline.” 

>>Open a clip into the Source Viewer, set In and Out points to define the range of media you 
want to insert, and then click the Insert Edit button in the toolbar, press the F9 key, or drag 
any clip onto the Insert overlay in the Timeline Viewer.

	 The selected clips are insert edited to the selected track at the position of the playhead, 
pushing all other media in the destination track back by the total duration of the selected 
clips, except for clips on other tracks that overlap to the left of the edit point (as seen by the 
overlapping music clip in the example below).
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Replace Edits

A replace edit automatically replaces a clip in the Timeline with a clip in the Source Viewer, using the 
duration of the Timeline clip to define the duration of the incoming media, and the positions of the 
Viewer and Timeline playheads to line up how the incoming media should be placed.

You can also use a replace edit to edit a clip into an empty track of the Timeline so that the frame 
at the position of the Source playhead is aligned with the Timeline playhead, and the In and Out 
points of the incoming clip fall where they may. This is useful when you want to “spot” a particular 
action of an alternate take or a cue in a sound effect to a specific frame of the Timeline.

Replace edits do not ripple the Timeline.

To replace a clip in the Timeline:

1.	 Move the playhead in the Timeline to the clip that you want to replace, and align it with a frame 
that you want to line up with a frame in the clip you want to replace edit into the Timeline.

2. 	 Click the appropriate audio and video destination controls of the track containing the clip you 
want to replace.

3. 	 Open a clip into the Source Viewer.

4. 	 Move the playhead in the Source Viewer to the frame that you want to line up with the frame 
at the position of the playhead in the Timeline.

Before and after an overwrite edit, the Timeline gets longer as non-overlapping clips to the left of the edit point are 

pushed to the right



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

254

EDIT6

5.	 Click the Replace Clip button, press F11, or drag any clip onto the Replace overlay in the 
Timeline Viewer.

	 The clip in the Timeline is now replaced with the clip from the Media Pool, with the source 
frame at the Source Viewer playhead aligned with the frame at the Timeline playhead.

Move the playhead over the clip you need to replace, and position the Source Viewer playhead on the matching frame

The resulting replace edit



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

255

EDIT6

Fit to Fill

Fit-to-fill edits are the only edit type that actually use all four edit points, and it’s the only edit 
type that retimes clips at the same time as they’re being edited. By setting In and Out points in 
the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch or 
compress the timing of the specified range of source media to cover the entire specified range of 
the Timeline. In the process, the speed ratio of the clip changes so the clip plays in either fast or 
slow motion.

Fit-to-fill edits are especially valuable when you have a source clip in which the action is slightly slow, 
and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also 
incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source 
clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit-to-fill edits do not ripple the Timeline.

To use Fit-to-fill to edit a clip into the Timeline:

1.	 Set both In and Out points in the Timeline to define the duration you want to fill with the 
incoming source clip.

Setting timeline In and Out points to mark a gap
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2.	 Set In and Out points in a longer or shorter source clip that you want to fill into the 
available space. 

3.	 Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks. 

4.	 Drag any clip onto the Fit-to-Fill overlay in the Timeline Viewer, or press Shift-F11.

	 The incoming source clip is retimed, if necessary, to fit into the specified duration of the Timeline.

Setting In and Out points in a source clip to define a shorter duration

The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap
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Place On Top

Place-on-top edits automatically superimpose clips onto the first empty track above any other clips 
in the Timeline that either intersect the playhead or fall in between the currently set Timeline In 
and Out points, regardless of the current track specified by the destination controls. It’s designed 
to make it easy to superimpose titles and other clips you want to composite over another clip, or to 
add additional versions of clips such as VFX on top of previous versions that you want to preserve.

Place-on-top edits create new timeline tracks if necessary, and do not ripple the Timeline.

To use Place-on-top to edit a clip into the Timeline:

1.	 To choose where in the Timeline the clip will be “placed on top,” do one of the following:

	 Move the playhead to intersect the clip you want to edit the incoming source clip on top of.

	 Set In and Out points in the Timeline to define the duration within which you want to place the 
incoming source on top.

2. 	 Set In and Out points in a source clip that you want to edit.

3. 	 Drag any clip onto the Place-on-Top overlay in the Timeline Viewer, or press F12.

>> Incoming video clips will be edited to the topmost video track so they are above any 
previously existing video in the Timeline. Incoming audio clips are edited to the bottom-
most audio track so they are below any previously existing audio. If necessary, new video 
and/or audio tracks will be created automatically to hold the new incoming clip.

Before and after using Place on top
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Append at End

Append at End always puts the edited clip at the very end of the current Timeline. It’s a very useful 
edit type when you’re quickly stringing together a series of clips.

To use Append at End to edit a clip into the Timeline:

1.	 Set In and Out points in a source clip that you want to add to the end of the current Timeline.

2. 	 Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks.

3. 	 Choose Edit > Append at End, or press Shift-F12.

	 Incoming video clips are added after the very end of the last clip in the Timeline.
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Match frame operations are a terrific time saver when you need to match the original source clip to 
a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same clip in 
the Timeline. With a single command, you can match one clip to another in order to set up a new 
edit to take care of a variety of tasks.

Matching From the Timeline

A classic example of using Match Frame is when you originally edited a video clip into the Timeline 
without its corresponding audio, and you later decide you want that audio in the Timeline after all. 
An easy fix is to move the playhead in the Timeline to intersect the clip you need to fix, and use 
the Match Frame command to automatically load the original source media for that clip into the 
Source Viewer, setting Source In and Out points that match those of the Timeline clip, and putting 
the Source playhead at the same frame as the Timeline playhead. At that point, you can simply edit 
the source audio and video back into the Timeline to overwrite the video-only clip you started with, 
confident that you’re editing exactly the same range of media at the same place.

To use Match Frame in the Timeline to find a source clip:

1.	 Move the Timeline playhead to intersect the clip you want to target.

2.	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target for Match Frame 
operations. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

Placing the playhead over a clip to match frame

Match Frame Operations
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3.	 Do one of the following:

>> Hold the Option key down and double-click the clip in the Timeline.

>> Click the Match Frame button at the bottom right of the Timeline Viewer (it’s at the left of 
the In and Out buttons).

>> Press the F key.

	 The original source media for that clip is automatically loaded into the Source Viewer, with In 
and Out points that match those of the targeted Timeline clip; the Source playhead is at the 
same frame as the Timeline playhead.

Matching From a Source Clip

Match Frame also works in the opposite direction. You can open a source clip into the Source 
Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame to 
automatically find the next clip in the Timeline with media found within the source clip.

To use Match Frame in the Source Viewer to find a clip in the Timeline:

1.	 Open a clip in the Source Viewer that includes a range of media that’s already been edited 
into the Timeline. If no part of the source clip has been edited into the Timeline, source match 
framing won’t work.

2. 	 Move the Source Viewer playhead to a frame that you want to find in the Timeline. Again, if the 
frame at the position of the playhead in the Source Viewer hasn’t already been edited into the 
Timeline, the Source Match Frame command won’t work.

3. 	 Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of the In 
and Out buttons), or press the F key.

Placing the playhead over a clip to match frame
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	 The Timeline playhead automatically moves to the clip and frame after the current playhead 
position that matches the clip in the Source Viewer.

Locating Source Viewer or Timeline Clips in the Media Pool

There are two ways you can locate the original clips in the Media Pool using corresponding clips 
that you’re working with:

>> Press Option-F to locate a clip that’s open in the Source Viewer in the Media Pool. That clip 
appears highlighted in the Media Pool.

>> To locate a Timeline clip’s corresponding clip in the Media Pool, right-click any clip in the 
Timeline, and choose Find in Media Pool. That clip appears highlighted in the Media Pool.
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Once you’ve assembled a group of clips in the Timeline, you’ll probably need to manipulate them 
further, moving, deleting, trimming, and otherwise adjusting the clips in the Timeline to make the 
edit play with the pacing and verve you require.

Selecting Clips in the Timeline

Many operations require you to make a selection first, to define the scope of what you’re about to 
do. There are many ways to do so.

Selections you can make using the mouse:

>> To select one clip: Click a clip with the mouse. 

>> To select a continuous range of clips: Drag a bounding box from an empty area of the 
Timeline to surround a group of clips. 

>> To select a discontinuous range of clips: Command-click any clips to select them no matter 
where they appear on the Timeline.

Selecting a continuous range of clips in the Timeline

Selecting a discontinuous range of clips in the Timeline

Selecting and Deleting Clips in the Timeline
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Selecting clips using the keyboard or menu commands:

>> To select one clip: Using the keyboard, make sure the Auto Select button for the track the 
clip is on is enabled, then move the playhead over that clip and press Shift-V.

>> To select all clips forward on the current track: Move the playhead to the first clip you want 
to include in the selection, then press the Y key (Edit > Select Clips Forward On This Track) 
to select that clip and every clip to its right in the same track of the Timeline.

>> To select all clips forward of the playhead on all tracks: Move the playhead to the first clip 
you want to include in the selection, then press Option-Y (Edit > Select Clips Forward On 
All Tracks) to select that clip and every clip to its right in all tracks of the Timeline.

>> To select all clips backward on the current track: Move the playhead to the last clip you 
want to include in the selection, then choose Edit > Select Clips Backward On This Track to 
select that clip and every clip to its left in the same track of the Timeline. By default, there’s 
no keyboard shortcut for this command, but you can assign one.

>> To select all clips backward of the playhead on all tracks: Move the playhead to the last 
clip you want to include in the selection, then choose Edit > Select Clips Backward On All 
Tracks to select that clip and every clip to its left in all tracks of the Timeline. By default, 
there’s no keyboard shortcut for this command, but you can assign one.

>> To select all clips in the Timeline: Make sure the Timeline has focus, then press Command-A.

To change which clip is selected using the keyboard:

>> Select a clip, then use the Left Arrow and Right Arrow keys to change the selection to the 
previous or next clip among all tracks with Auto Select turned on.

To deselect all clips:

>> Using the mouse: Click in any empty area of the Timeline.

>> Using the keyboard: Press Shift-Command-A.

Using the Timeline Auto Select Controls to Define Selections

The Timeline Auto Select controls give you a way of specifying which tracks will be either affected 
or considered during operations in which there are multiple superimposed clips on multiple tracks 
of the Timeline. In the easiest example, if you have two superimposed clips, and you want to delete 
the media from only the clip on track V1, you can turn off the Auto Select control for track V2, set 
Timeline In and Out points to define the range of the clip you want to delete, and then when you 
press the Delete key, only the media on the Auto Select-enabled track is deleted.
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Another type of operation affected by Auto Select is when using the Mark Clip command, again on 
a section of the Timeline where there are multiple superimposed clips, each of which has a different 
duration. Ordinarily, the first and last frames of the clip on the lowest track is used to set Timeline In 
and Out points when using Mark Clip. 

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest 
video track with Auto Select still enabled is used as the target clip for the Mark Clip operation. In 
this example, the shorter clip on track V2 now sets the locations of the In and Out points.

Methods of enabling and disabling the Auto Select controls:

>> To toggle Auto Select for any track: Click any track’s Auto Select control.

>> To toggle Auto Select for video tracks: Press Option-F1 through F8 to toggle Auto Select 
for tracks V1 through V8. 

>> To toggle Auto Select for all video tracks off and on: Press Option-8.

Using Mark Clip with all Auto Select controls enabled

Using Mark Clip with all Auto Select controls enabled
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>> To toggle Auto Select for audio tracks 1-9: Press Option-Command-F1 through F8. 

>> To toggle all video track Auto Select tracks off and on: Press Option-F9.

>> To toggle all audio track Auto Select tracks off and on: Press Option-Command-F9.

>> To “solo” Auto Select for a track and disable Auto Select on all other tracks: Option-click 
any Auto Select control to leave that control on while turning off all other Auto Select 
controls of that type (video or audio).

>> To turn all audio or video Auto Select controls on and off: Shift-click any video or audio 
Auto Select control to toggle on or off all Auto Select controls of that type (video or audio).

The following operations are affected by the state of each track’s Auto Select control:

>> Deleting clips: When using Timeline In and Out points to delete a range of media from the 
Timeline, only media on tracks with an enabled Auto Select control will be deleted.

>> Deleting gaps: When selecting and deleting gaps in the Timeline, clips on other tracks 
that overlap the selected gap will also be deleted on tracks with an enabled Auto Select 
control. Media to the right of affected tracks will ripple left to close the gap.

>> Selecting clips using the keyboard: When a clip is selected, you can press the Up Arrow 
and Down Arrow keys to move the selection from clip to edit clip, but clips on tracks with a 
disabled Auto Select control are not seen by this operation.

>> Using Mark Clip: When making a Mark Clip operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

>>Match Frame: When making a Match Frame operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

>> Rippling the Timeline: Tracks with Auto Select turned off will not be rippled. More 
information on the rules of ripple trimming appear later in this chapter.

>> Pasting clips: All copied clips will be pasted to the lowest numbered track with Source 
Control enabled.

>> Finding gaps: When using Playback > Previous Gap or Next Gap, gaps on tracks with Auto 
Select disabled will be ignored.
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Deleting Clips From the Timeline

There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, 
you can perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving a 
gap. Using the Forward Delete key, you can perform a “ripple delete,” removing unwanted clips 
and closing the gap by rippling the rest of the edited Timeline to the right of the deleted clip/s by 
moving it to the left.

Deleting clips as a “lift edit” operation:

>> To remove one or more clips from the Timeline, leaving a gap: Select a clip in the Timeline, 
or Shift-click or Command-click to select the clips you want to remove, and press the Delete 
key (or right-click the selection and choose Delete).

>> To remove a range of media from the Timeline on multiple tracks, leaving a gap: Set Timeline 
In and Out points defining the range of media you want to delete, then turn off the Auto 
Select controls of any tracks with media you want to preserve, and press the Delete key (or 
right-click the selection and choose Delete).

Deleting a range of clips and leaving a gap
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Deleting clips as a “ripple delete” operation:

>> To delete one or more clips and close the gap by rippling the Timeline left: Select a clip in 
the Timeline, or Shift-click or Command-click to select the clips you want to remove, and 
press the Forward Delete key.

>> To delete a range of media and close the gap by rippling the Timeline left: Set Timeline In 
and Out points defining the range of media you want to delete, then turn off the Auto Select 
controls of any tracks with media you want to preserve, and press the Forward Delete key.

As with any ripple operation, any clips that overlap the affected range of media to the left 
are unaffected.

Deleting a range of clips and rippling the Timeline to close the gap
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Finding, Selecting, and Deleting Gaps in the Timeline

A gap is defined as a space between any two clips on the same track. Often gaps are desirable as 
they allow audio or video clips to be spaced apart from one another very specifically, but sometimes 
they’re not. If you want to find accidental gaps in your timeline that may be too small to see, a pair 
of commands lets you do this.

To move the playhead to the next gap on the Timeline:

1.	 Turn off the Auto Select controls of any tracks you want to omit from this operation.

2.	 Do one of the following:

>> Choose Playback > Previous Gap, or press Option-Command-Semicolon (;) to move the 
playhead to the next gap to the left of the playhead’s current position.

>> Choose Playback > Next Gap, or press Option-Command-Apostrophe (‘) to move the 
playhead to the next gap to the right of the playhead’s current position.

To select or deselect a gap:

>> Click once to select a gap, and click that gap again to deselect it.

You can only select one gap at a time. The principal reason to select gap is to delete it, in the 
process rippling the Timeline to close the gap. In the following example, there’s a gap between two 
clips on track V1 that you’d like to close.

Selecting a gap On Track V1

To delete a gap:

>> Press the Delete key to close the gap.,All clips to the right of it on tracks with Auto Select 
enabled will be rippled to the left to close the gap. Clips on tracks with Auto Select disabled 
will not ripple.
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If you select a gap in a timeline with clips on multiple tracks, which clips will be deleted depends on 
the state of the Auto Select controls for each track in the Timeline.

>> All tracks with Auto Select enabled: The range of media that overlaps the selected gap will 
also be deleted. Clips on those tracks will ripple left to fill the gap.

>> All tracks with Auto Select disabled: The range of media that overlaps the selected gap will 
be left intact, and clips on those tracks will not ripple left, going out of sync with whichever 
clips do ripple.

Trimming Gaps

The start and end of gaps can also be rippled using the Trim tool. For more information, see “Using 
Trim Mode and the Trim Tool” later in this chapter.

Selecting Edits in the Timeline

A variety of trimming methods require you to select an edit point, or part of an edit point, in order 
to resize, ripple, or roll an edit. You can do so using the mouse, or using the keyboard.

Methods for selecting edit points using the mouse:

>> To select an edit to roll: Move the mouse to the center of an edit point, and when the ripple 
cursor appears, click to select the edit.

>> To select just the incoming or outgoing half of an edit point to resize or ripple: Move the 
mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, 
click to select that portion of the edit.

Selecting an edit point to roll
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To select multiple edit points, do one of the following:

>> Command-click multiple edit points, up to one per track.

>> Click to select the Trim tool (T), and drag a bounding-box over the edit points you want to 
select, up to one per track.

There are also a flexible set of keyboard shortcuts that make it easy to select edit points in 
preparation for various operations if you like to avoid using the mouse.

Keyboard shortcuts for selecting edits:

>> V: Selects the nearest edit point to the playhead on the lowest track with Auto Select enabled.

>> U: Once you’ve selected an edit point, this shortcut toggles among selecting the outgoing 
half, incoming half, or the entire edit.

>>Option-U: Once you’ve selected an edit point, this shortcut toggles among selecting the 
video+audio of the edit, just the video, or just the audio.

To move the selection to another edit

>> Select an edit point, then use the Left Arrow and Right Arrow keys to change the selection 
to the previous or next edit point among all tracks with Auto Select turned on.

To deselect all edit points:

>> Using the mouse: Click in any empty area of the Timeline.

>> Using the keyboard: Press Shift-Command-A.

Here’s an example of how you would use these keyboard shortcuts together as a sequence of 
operations. To turn Audio/Video Linking off and on:

Selecting incoming or outgoing halves of an edit point to resize or ripple
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To select an edit point using the keyboard:

1.	 Move the Timeline playhead close to the edit point you want to select using the JKL keys.

2.	 Press the V key to select the nearest edit point to the playhead on the lowest track with Auto 
Select enabled. If there are overlapping superimposed clips on multiple tracks, turn off the 
Auto Select controls of tracks with edits you don’t want to select using Option-F1 through 
Option-F9 corresponding to the auto select controls on tracks 1-9. Using the mouse, you can 
solo a track’s Auto Select state by Option-clicking its Auto Select button.

3.	 Initially, the entire edit is selected, in preparation for a roll edit. To toggle among selecting the 
outgoing half, incoming half, and the entire edit, press the U key.

4.	 To toggle among selecting the video+audio of the edit, just the video, or just the audio, 
press Option-U.

5.	 Perform whatever operation you need to. When you’re finished, using Up-Arrow or Down-
Arrow to move the selection backward or forward in the Timeline, or press Command-Shift-A 
to deselect it.

Linking and Unlinking Audio and Video

While selecting edits and clips, you can also choose whether the video and audio associated with a 
clip should be selected together (linked) or not. This determines whether operations performed to 
the video of a clip automatically affect the audio of the clip, and vice versa. In most instances, you’ll 
probably want to leave Audio/Video Linking turned on, so that selecting the video of a clip to move 
it elsewhere in the Timeline also results in the audio being selected and moved at the same time. 
Disabling A/V linking in this case could cause your video and audio to go out of sync undesirably.

However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V 
relationship, such as when you want to create a split edit, where a clip’s audio In point is at a different 
frame then the video In point. In this case, you can suspend Audio/Video Linking to select just the 
audio In point, then roll it either further back or forward to create the split, without changing the In 
point of that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Audio/Video Linking is visible via the chain-link button at the right of 
the toolbar.

The Audio/Video Linking button
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To turn Audio/Video Linking off and on:

>> Click the Link Audio/Video button (or press Shift-Command-L).

To temporarily suspend Audio/Video Linking while making a selection:

>> Press the Option key while clicking a clip or edit point to select the video without selecting 
the audio, or vice versa.

Methods of permanently changing Audio/Video Linking in the Timeline:

>> To unlink audio and video from one another: Select a clip, then right-click it and choose Link 
from the contextual menu (or press Command-L). Unlinked clips do not appear with a dot 
before the clip name in the Timeline.

>> To link audio and video clips to one another: Command-click an audio clip and a video 
clip so they’re both selected, then right-click the selected clips and choose Link from the 
contextual menu (or press Command-L). A dot appears before the name of linked clips in 
the Timeline.

Dealing with Audio Video Sync Offsets

Audio/Video sync is one of the most important things to maintain in any edited program. However, 
there are times when you may want to override the sync relationship of a clip’s audio and video to 
make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Audio/Video Linking and then move the audio or video of a clip independently of its 
linked video or audio counterpart, you’ll see red windows overlapping the clip names that display 
the timecode offset by which the audio and video of that clip are out of sync. In the following 
example, the audio and video of a clip have been moved out of sync by Option-clicking the video 
and dragging it to the right.

Left - linked video and audio with a dot to the left of the name, Right - unlinked audio and video has no dot



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

273

EDIT6

Commands for Slipping Sync

A set of commands in the Slip Audio/Eye submenu of the Edit menu let you alter the sync between 
the audio and video of any clip.

>> Slip Audio One Frame Forward

>> Slip Audio One Frame Reverse

Locking Tracks

Another step you can take to prepare before an edit is to lock tracks with media that you don’t 
want to be affected by operations you’re about to perform. For example, if you have a complex 
set of music edits on track A3 that you don’t want to be affected by operations that will ripple the 
Timeline, you can lock track A3 so those clips remain unaffected.

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. 
Furthermore, parameters of locked clips cannot be edited in the Inspector. However, clips on locked 
tracks can be graded and otherwise modified in the Color page.

To toggle the lock or unlock state of tracks, do one of the following:

>> Click any track’s lock control.

>> Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.

>> Press Option-Shift-9 to lock or unlock all video tracks.

>> Press Option-Shift-F1 though F8 to lock or unlock tracks A1 through A8.

>> Press Option-Shift-8 to lock or unlock all audio tracks.

Sync markers on a clip with audio and video out of sync
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After editing a series of clips into a timeline, the next thing even the most careful of editors probably 
needs to do is to start making changes. The simplest changes are made in Normal Edit Mode, using 
the regular arrow pointer. 

This is the default mode when you open Resolve, and allows you to move clips to other places in the 
Timeline, resize them to make them longer or shorter, and roll the edit points between two clips to 
move the edit to happen earlier or later.

Manipulating clips using the mouse:

1.	 Click the ”Normal Edit Mode” tool (the arrow).

2.	 Do one of the following:

>> To move clips in the Timeline: Drag any clip in the Timeline to any other position. If you drag 
a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re 
dropping it onto.

Moving a clip in the Timeline to overwrite part of another clip; a tooltip shows you how many frames you’ve moved

The Normal Edit mode button at left, the Trim mode button at right

Moving and Trimming Clips in Selection Mode
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>> To move clips in the Timeline up or down to other tracks while keeping them at the same 
time: Hold the Shift key down while dragging clips up or down in the Timeline.

>> To shorten or lengthen clips: Move the Normal Edit Mode pointer over the beginning or 
end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or 
right to change the clip’s length. 

>> To roll any edit: Move the Normal Edit Mode pointer over any edit point, and when it turns 
into the Roll Edit cursor, drag it to the left or right to move the edit point while simultaneously 
resizing the outgoing and incoming edits points of the two clips surrounding it.

Resizing a clip in the Timeline to create a gap; a tooltip shows the offset, and outlines show you how much media 

is available in the clip being adjusted

Rolling an edit; a tooltip shows the offset, and an outline shows the available area you can roll within
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Manipulating clips using the keyboard:

1.	 Press A to choose ”Selection Mode.”

2.	 Do one of the following:

>> To roll any edit: Select the closest edit point to the playhead using the V key, moving the 
selection to another edit if necessary using the Left Arrow and Right Arrow keys, and then 
press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the 
selected edit to the left or right. Shift-Comma and Shift-Period nudges by 10 frames.

>> To shorten or lengthen clips: Select the closest edit point to the playhead using the V key, 
then use the U key to toggle the selection among the end of the outgoing clip and the 
beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or Period 
key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge one 
end of a clip to overlap another, the clip you’re nudging overwrites the adjacent clip. Shift-
Comma and Shift-Period nudges by 10 frames.

>> To move clips forward or back in the Timeline: To select a clip in preparation for moving 
it, either click it, or move the playhead over it and press Shift-V. Then press the comma 
(nudge 1 frame left) or period (nudge 1 frame right) to move the clip to the left or right. If 
you nudge a clip to overlap another clip, the clip you’re nudging overwrites the adjacent 
clip. Shift-Comma and Shift-Period nudges by 10 frames.

>> To move clips up or down to other tracks: To select a clip in preparation for moving it, either 
click it, or move the playhead over it and press Shift-V. Then, press Option-Up Arrow to 
move the Video and Audio of that clip to the next higher-numbered track, or press Option-
Down Arrow to move the Video and Audio to the next lower-numbered track.

Trimming Clips in the Source Viewer Using the Selection Tool

You can also double-click a clip in the Timeline to open it into the Source Viewer for trimming. When 
the Selection Tool is selected, you can drag the In and Out markers, or use the playhead and I and 
O keyboard shortcuts to resize that clip in the Timeline.
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A Timeline clip being resized by opening it in the Source Viewer and dragging its In point

Additionally, you can open timeline clips into the Source Viewer for trimming using the Trim tool, 
dragging to ripple the In and Out points, and slipping the contents of the clip by holding the Shift 
key down and dragging the In and Out points.

Note: To open a match frame of a clip in the Timeline using the mouse as in previous versions of 
Resolve, hold the Option key down while double-clicking a clip.
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Swap Edits and Swap Inserts

A swap edit lets you rearrange clips in the Timeline by dragging them to the left or right within an 
edited sequence of other clips, and the surrounding clips automatically move to the right or left to 
switch places with the clip you’re dragging.

To swap edit one clip adjacent clips in the Timeline:

>> Select the clip you want to swap, then press and hold the Command and Shift keys down 
and drag the selected clip to the left or right. Adjacent clips will automatically switch places 
with the clip you’re dragging, until you drop it in the desired location.

A clip being swapped with adjacent clips in a scene in order to rearrange the sequence

To swap insert one clip into adjacent clips in the Timeline:

>> Select the clip you want to swap, then press and hold Command and Option keys down 
and drag the selected clip to the left or right. The clip you’re dragging will be inserted in 
the middle of adjacent clips as you drag, with the cut portion of each clip being moved 
into the gap left behind by the clip you’re dragging. Drop the clip into the desired location 
when you’re finished.
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A clip being inserted into the middle of adjacent clips; the split part of each clip is swapped  

with the inserted clip’s former location in order to rearrange the sequence

Splitting and Joining Clips

In many situations you may find yourself splitting clips in order to separate multiple clips that were 
inadvertently baked together, or to cut up clips into sections that you’re planning on applying 
different effects to or grading differently.

Methods of splitting and joining clips:

>> To split a clip once: Drag the playhead to the frame where you want to split a clip, and press 
Command-Backslash (\) to split every clip on a track with Auto Select enabled.

>> To split many clips: Click the Razor Edit mode button (or press B), and then click clips in the 
Timeline to split as many clips as you want.

>> To split clips using the DaVinci control surface on the Color Page: Move the playhead to the 
frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-bar panel.
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>> To join clips using the DaVinci control surface on the Color Page: Move the playhead to the 
edit point you want to join, and press SHIFT UP and JOIN/REDO on the T-bar panel. Both 
clips must be from the same media file, and the frames to either side of the edit point need 
to be continuous for those clips to be joined.

When you split a clip, a through edit appears to show that you currently have an edit with continuous 
timecode running from the outgoing to the incoming half. This is called a through edit, and is 
displayed with a dotted line running along its edge so you know that it’s special.

To eliminate a through edit:

>> Select it in the Timeline, and press Delete.

Note: You can show an isolated list of every through edit in the Timeline by opening the Edit Index 
and choosing “Show Through Edits Only” in the Edit Index Option menu. Clicking any item in 
the list jumps the playhead to that through edit, making it easy to check all the through edits in a 
timeline to see if they’re necessary or not.

Copying and Pasting Clips in the Timeline

Clips can be cut, copied, and pasted using standard keyboard shortcuts. You can cut or copy one 
clip or a selection of several, and you can also choose to copy or cut just the video or audio media 
of a clip. When pasting, you can paste to the same timeline, or to a different timeline if you want to 
move media from one to another.

Methods of doing cut, copy, and paste:

>> To Cut one or more clips, leaving a gap: Make a selection, and press Command-X.

>> To Copy one or more clips: Make a selection, and press Command-C.

A through edit seen in the Timeline
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>> To Paste one or more clips to the same track: Move the playhead to the frame where you 
want the pasted selection to start, Option-click the Auto Select control of the track you 
want to paste the clip(s) to so solo that track, and press Command-V. Pasted clips overwrite 
any clips in that track that are in the way.

If all Auto Select controls are turned on, clips are always pasted back to the same track they were 
copied from, starting at the position of the playhead. However, you can force paste the selection 
to a different track by Option-clicking that track’s Auto Select control to solo it before pasting 
the clip. 

When one or more Auto Select controls are disabled, then clips are pasted to the lowest-numbered 
track with an enabled Auto Select control. If you’ve copied clips on multiple tracks, clips on the 
lowest copied track will be pasted to the lowest Auto Select enabled track, and all other clips will 
be pasted to higher tracks, with new tracks automatically created, if necessary.

If Auto Select is disabled on every single track, then a new track will be created above all other video 
tracks and/or below all other audio tracks, and the clip will be pasted into this new track, which has 
Auto Select turned on.

Copying and pasting audio has one other consideration. If you’re force pasting a clip into a different 
track, the track you solo the Auto Select control of must be capable of holding the type of audio 
clip you’re pasting. Otherwise, the clip will be automatically pasted to the lowest-numbered track 
capable of holding that clip, or a new track will be created if none exist.

Duplicating Clips and Transitions in the Timeline

Clips can also be duplicated by making a selection, and then Option-dragging the selected clips to 
another position and/or track in the Timeline. Individual selected transitions can be duplicated by 
Option-dragging to another edit point. 
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You can call attention to different clips and frames using flags and markers. Generally speaking, 
flags are for calling attention to overall clips of media, while markers are meant to denote specific 
frames for a particular clip. This section describes different ways you can use flags for reference, and 
markers for taking notes and aligning frames together with snapping.

Using Flags

Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares 
the same Media Pool source clip, making this a handy way of quickly identifying which clips in a 
given timeline come from the same Media Pool source.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging 
specific media files, flags can be useful for timeline filtering in the Color page, sorting by column in 
the Media Pool, and a variety of other operations.

Methods for flagging clips:

>> To flag a clip: Select one or more clips, and either click the Flag button to flag that clip with 
the current color, or click the Flag pop-up in the toolbar to choose a different color and 
then click the Flag button. In the Edit page, flags appear in the Timeline superimposed in 
the name bar of each clip.

>> To remove all flags from a clip: Select one or more clips with flags you want to remove, then 
click the Flag pop-up in the toolbar, and choose the top “Clear All” option.

>> To filter all flagged clips in the Edit Index: Click the Option menu of the Edit Index and 
choose Show Flags. Each flagged clip appears in a list, with a column showing the color(s) 
of the flags applied to each entry in the list.

The Flag and Marker buttons and pop-ups

Flagging and Marking Clips for Reference
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Using Markers

Markers are used to call attention to a particular frame within a specific clip. You can place markers 
on the jog bar of source clips in the Source Viewer (or the Media page Viewer), on clips in a timeline, 
or on the Timeline ruler. 

Markers placed on clips snap to clip In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled.

Methods of marking clips:

>> To mark a source clip in the Media Pool: You can also add markers to clips in the Media 
Pool, for future reference when editing, by opening a clip in the Source Viewer, moving 
the playhead to the frame you want to mark, and then pressing M. Source clip markers are 
preserved in the Media Pool for future reference.

>> To mark a clip in the Timeline: Select one or more clips you want to mark, and then move 
the playhead to a frame of a selected clip in the Timeline, and click the Marker button 
(or press M) to place a marker at that frame, using the current color. You can also click 
the Marker pop-up to choose a different color, and then click the Marker button. Markers 
appear in the Timeline at the top of the clip to which they’re applied.

>> To remove a single marker: Click to select the marker you want to delete, and press the 
Delete key (or press Option-M).

>> To remove all markers from a clip: Select one or more clips with markers you want to remove, 
then click the Marker pop-up, and choose Clear All.

(Top) Markers placed on a source clip, (Bottom) Markers placed on a clip in the Timeline
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You can also place markers of any color into the Timeline ruler, to denote specific times for  
future reference.

You should note that all markers placed on clips or in the Timeline also appear within the Mini-
Timeline of the Color page, making it easy to place notes for later reference when grading.

Methods of marking the Timeline:

>> To mark the Timeline: Make sure all clips are deselected, then click the Marker button (or 
press M) to place a marker of the currently selected color in the Timeline ruler.

>> To remove a single marker from the Timeline: Move the playhead to the frame of the marker 
you want to remove, and press Shift-M.

>> To remove all marks from the Timeline: With all clips deselected, choose Clear All from the 
marker pop-up menu in the Toolbar.

Using Markers to Navigate

Markers can be used to aid navigation, via two keyboard shortcuts that let you jump the playhead 
from marker to marker. When moving the playhead among markers, clip and timeline markers are 
mixed together.

To move the playhead to the next or previous marker:

>> Press Shift-Up Arrow to move the playhead to the next marker to the left in the Timeline.

>> Press Shift-Down Arrow to move the playhead to the next marker to the right in the Timeline.

You can also use the Edit Index to filter out a list of all markers appearing within the current Timeline. 
Columns expose the notes and colors applied to each marker, making it easy for you to sort 
markers by color, alphabetically by note, or by the source or record timecode of the clip to which 
they’re applied.

Timeline markers placed for future reference
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Methods of working with markers in the Edit Index:

>> To filter all clips with markers in the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers. Each clip with one or more markers appears in a list, with column 
corresponding to the color(s) and notes of each timeline and clip marker.

>> To move the playhead to the position of a marker in the Edit Index: Click that marker’s entry 
in the list.

>> To show hidden marker columns: Right-click any column, and choose either Color or 
Notes to reveal that column. If necessary, columns can be rearranged by dragging them 
left or right.

Editing and Moving Markers

Markers and Flags can be edited after they’ve been added, and timeline markers can be set to 
optionally ripple to follow along with any ripple trimming done in the Timeline.

Methods of editing markers:

>> To add a note to a marker: Move the playhead to the frame containing the marker you want 
to annotate and press Option-M, or double-click the marker you want to edit, then type 
your note in the text field field within the marker dialog, and click Done.

>> To change a marker’s color: Move the playhead to the frame containing the marker you 
want to annotate and press Option-M, or double-click the marker you want to edit, click the 
button of the color you want to use in the marker dialog, then either click Done.

To enable Marker rippling:

>> Choose Edit > Ripple Timeline Markers. When checked, all markers to the right of a clip 
being ripple edited or ripple deleted will ripple to the left along with the rest of the Timeline. 
You can turn this behavior off and on at will.
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Most editors would agree that trimming is half the job of editing. While you can make many kinds of 
changes in the Timeline using the selection and razor blade tools, there is a dedicated Trim mode 
in which you can perform more sophisticated trim operations in fewer steps using either the mouse 
or keyboard shortcuts, depending on how you like to work. Mastering DaVinci Resolve’s trimming 
operations will save you time when doing the necessary work of fine-tuning your edit.

Trim mode differs from Selection mode in that operations that would move clips with the Selection 
tool will either slip or slide clips with the Trim tool. Other operations that would resize edits with 
the Selection tool instead ripple the Timeline to automatically close gaps when using the Trim tool. 
The following sections describe the various trim operations that are available, both when using the 
mouse, and when using the keyboard. 

To enter Trim Edit mode:

>> Click the Trim Edit button, or press the T key.

Summarizing Trim Operations

Before going into the different methods of trimming that are available, users who are new to editing 
might benefit from a quick summary of what each trimming operation actually does. Each trim 
operation is designed to let you move edits and clips in relation to whichever clips are around them, 
by performing several operations at once. The four primary methods of trimming are:

>> Roll: Moves an edit point to the left or right by either shortening the outgoing clip while 
lengthening the incoming clip, or vice versa. Roll edits do not change the duration of the 
overall Timeline.

>> Ripple: Shortens or lengthens the end of an outgoing clip or the beginning of an incoming 
clip, while simultaneously moving all clips to the right in the Timeline to fill the gap that 
would otherwise occur if you were doing a resize operation. Ripple edits do change the 
duration of the overall Timeline, and can alter the sync relation between different tracks if 
you’re not careful.

>> Slip: Keeps a clip in the same place in the Timeline, while changing the range of media that 
appears in that spot. Slip edits do not change the duration of the overall Timeline.

>> Slide: Keeps a clip’s range of media the same, but moves that clip to the left or right by 
either shortening the outgoing clip to its left while lengthening the incoming clip to its 
right, or vice versa.

Rippling Gap

You can also use the Trim Tool (or other trim operations described later in this chapter) to ripple the 
start and end of a gap in the Timeline. Rippling a gap lets you grow or shrink the gap while moving 
the portion of the Timeline to the right of the gap forward or backward in time.

Using Trim Mode and the Trim Tool
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Using the Trim Tool With the Mouse

When trimming using the mouse, you can perform every kind of trim operation that’s available using 
a single tool, simply by clicking the Trim mode/tool button, and then dragging on the appropriate 
area of a clip in the Timeline.

Methods of trimming with the mouse in Trim Edit mode:

>> To slip a clip: To slip a clip’s range of content without changing its position in the Timeline, 
click the middle top region of a clip, and then drag to the left or right to “slip” the clip to 
contain a different range of frames. A dashed overlay shows the total duration of media 
available for you to slip with, which moves left and right as you drag.

Clicking the top clip area before a slide, an overlay shows the clip’s available range of media

After dragging to slip, clips don’t move, but the slipped clip’s range of media has changed

When slipping clips, a 4-up display shows all relevant outgoing and incoming frames, so you 
can compare the continuity of action from one clip to the next. During a slip, the top two frames 
update to show you the new incoming and outgoing frames of the clip being slipped, relative to 
the unchanging outgoing frame of the clip to the left and incoming frame of the clip to the right.
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>> To slide a clip: To slide a clip, moving it to another position in the Timeline while 
simultaneously adjusting the Out point of the previous clip and the In point of the next 
clip to accommodate the change in position of the current clip being dragged, click the 
bottom-middle name bar of the clip and drag it to another position.

Four-up display when slipping a clip

After dragging to slide, the selected clip is at a new location, surrounding clips filled the gap
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When sliding clips, a 4-up display shows all relevant outgoing and incoming frames, so you can 
compare the continuity of action from one clip to the next. During a silde, the bottom two frames 
update to show you the new outgoing frame of the clip to the left, and the new incoming frame of 
the clip to the right of the clip being slid.

Four-up display when sliding a clip

>> To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In 
point of the incoming clip at the same time, drag an edit point between two clips to the left 
or right. (Roll edits can also be done in Normal Edit mode.)

Selected edit point before roll
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When rolling an edit, a 2-up display shows the changing continuity of action from the outgoing 
frame of the clip to the left to the incoming frame of the clip to the right.

Four-up display when rolling an edit

>> Ripple Edit: To ripple the outgoing or incoming part of an edit to add or remove media to 
a clip while simultaneously moving all other clips at the left in the Timeline to make room, 
click the Ripple tool, and drag an edit point to a new position in the Timeline.

Edit point moved further to the right, both adjacent clips resized to prevent gap
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When rippling an edit, a 2-up display shows the continuity of action from the outgoing frame of the 
clip to the left to the incoming frame of the clip to the right. Which frame updates depends on 
which side of the edit you’re rippling.

Four-up display when rippling an edit

Rippled clip is shorter, the rest of the Timeline has moved left to fill the gap

Selected incoming half of an edit point before ripple
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Trim Tool Operations With the Keyboard

You can also perform every trim operation more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1.	 Press T to select the Trim tool. 

2.	 To trim the selection, do one of the following:

>> To slide a clip: Press Shift-V to select a clip, and press the Comma key to slip it one frame to 
the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-Period slips 
the clip in 10 frame increments.

>> To slip a clip: Press Shift-V to select a clip, then press the S key to toggle to Slip mode 
(pressing S again toggles back to Slide mode) and press Comma or Period to slide its 
contents to the left or right. Shift-Option-Comma and Shift-Option-Period slides the 
contents in 10 frame increments.

>> To roll an edit: Press V to select an edit point, then press the Comma key to nudge it one 
frame to the left, or the Period to nudge it one frame to the right. Shift-Comma and Shift-
Period rolls the edit in 10 frame increments.

>> To ripple an edit: Press V to select an edit point, then press U to select either the incoming 
or outgoing side of the edit by itself. Then, press the Comma key to ripple the selected In 
or Out point of the clip to the left, or the Period to ripple it one frame to the right. Shift-
Comma and Shift-Period ripples in 10 frame increments.
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Important Trimming Keyboard Shortcuts

When trimming using the keyboard, the following keyboard shortcuts are important for you 
to remember.

Important: While the Slip, Roll, and Slide tools will change the sync relationship of the clips you’re 
adjusting with a matching soundtrack, the rest of the Timeline won’t be affected. Using the Ripple 
tool can alter the overall sync relationship of large portions of your timeline and its matching 
soundtrack, so you should use it with extreme care in situations when you’re grading a locked edit 
with audio that is being mixed at the same time.

Key Shortcut Function

T Trim mode, ripples edits and slips or slides clips.

A Selection mode, resizes edits and moves clips.

S Toggles between Slip and Slide mode when 
a clip is selected in Trim mode.

V Selects the edit point closest to the playhead, 
and moves the playhead there.

Shift-V

Selects the clip or gap that intersects the playhead, and 
moves the playhead to the center of the clip or gap. If there 

are superimposed clips, turn off the Auto Select controls 
of tracks containing clips you don’t want to select.

Option-F1 through F9
Toggles Auto Select for video tracks 1 through 9, 

making it possible to restrict certain selection and trim 
operations performed with the keyboard.

Command-Option 
F1 through F9

Toggles Auto Select for audio tracks 1 through 9, 
making it possible to restrict certain selection and trim 

operations performed with the keyboard.

U Toggles the currently selected edit point among the 
outgoing, centered, or incoming part of the edit.

Option-U Toggles the currently selected edit point or clip among 
Video+Audio, Video Only, or Audio Only.

Comma (,) After you’ve made a selection, nudges selected edits or clips 
one frame to the left. Shift-Comma nudges 10 frames.

Period (.) After you’ve made a selection, nudges selected edits or clips 
one frame to the right. Shift-Period nudges 10 frames.

Forward-Slash (/)
Play around. Plays around the current position of the playhead; good 
for letting you preview how the trim you just made plays. Pre-roll and 

Post-roll is adjustable in the Edit panel of the Project Settings.

Command-/ Toggles looped playback off and on.

Up Arrow, Down Arrow

Moves the selection state to the edit point or clip to the left or 
right. If multiple clips or edits are superimposed, the first clip 
on the lowest numbered track will be selected first, then the 

next clip up, and so on until the topmost superimposed clip is 
selected, before selecting the next clip in the Timeline.
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Trimming Using Timecode Entry

You can also use absolute or relative timecode entry to trim clips and edits. What is trimmed depends 
on the selection you’ve made prior to entering timecode. If you want to use timecode to trim the 
selection forward relative to its current position, be sure to type an equal sign or plus (= or +) before the 
timecode value; to trim the selection backward relatively, type minus (–) before the timecode value.

>> To roll an edit: Select the center of an edit point, enter a timecode value, and press Return.

>> To ripple an edit: Select either the outgoing or incoming half of an edit point, enter a 
timecode value, and press Return.

>> To slip a clip: Select a clip, and press S if necessary to switch to Slip mode, enter a timecode 
value, and press Return.

>> To slide a clip: Select a clip, and press S if necessary to toggle to Slide mode, enter a 
timecode value, and press Return.

When entering timecode, type each pair of hour, minute, second, and frame values consecutively, 
with a period representing a pair of zeros for fast entry. The last pair of timecode values (or period) 
you enter is always assumed to be the frame number, with any untyped values assumed to be zero. 
It’s not necessary to enter colons or semicolons. For more information on how timecode entry 
works, see “Navigating Using Timecode” in this chapter.

Trimming Clips in the Source Viewer Using the Trim Tool

You can also open Timeline clips into the Source Viewer for trimming using the Trim tool, dragging 
to ripple the In and Out points.
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A Timeline clip being ripple-resized by opening it into the Source Viewer  

dragging its In point using the Trim tool

You can slip the contents of the clip by holding the Shift key down and dragging either the In or 
Out point.

A Timeline clip being slipped by opening it into the Source Viewer and Shift-dragging its In point using the Trim tool

Additionally, you can double-click a clip in the Timeline to open it into the Source Viewer for 
trimming. When the Selection Tool is selected, you can drag the In and Out markers, or use the 
playhead and I and O keyboard shortcuts to resize that clip in the Timeline.

Note: To open a match frame of a clip in the Timeline using the mouse as in previous versions, hold 
the Option key down while double-clicking a clip.
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Ripple Editing Rules

Ripple operations are the only trim functions that change the duration of the overall Timeline, and 
that can potentially alter the sync relationship between multiple clips on different tracks. This makes 
them incredibly useful, but it’s important to understand which parts of the Timeline will move as 
part of a ripple operation, and which parts won’t.

The following operations ripple the Timeline:

>> Ripple deleting a clip

>> Rippling one or more edits or gaps using the Trim tool

>> Using the extend edit, trim start, or trim end commands in Trim mode

During a ripple edit, superimposed clips with an In point that’s to the left of the edit point or clip 
being rippled are not moved. This can be seen in the previous example via the audio clip at the 
bottom of the Timeline, which stays in place even as the clips on track V1 and A1 are rippled. All clips 
with In points to the right of the edit point or clip being rippled move left to follow the trim operation 
you’re making.

The rules of timeline rippling illustrated. All clips that are either to the left or that intersect the edit being rippled are left in place, while 

all clips to the right of the edit being rippled are moved to the right or left for the duration of the ripple operation

This simple rule means that, if you’re in the habit of building sequences of clips from left to right, 
long overlapping superimpositions such as titles, graphics, and music clips will stay in place while 
you’re rippling various clips within a montage that you’re editing in relation to these longer clips.

Using Auto Select Controls to Control Trimming

Each track’s Auto Select control can be used to control how trimming operations affect timelines 
with multiple tracks and superimposed clips by letting you turn off rippling on specific tracks, while 
leaving it on for others. The rules are simple:

>> Tracks with Auto Select turned on: Rippling or ripple deleting a clip ripples all clips to the 
right on that track.

Not Rippled Rippled



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

297

EDIT6

>> Tracks with Auto Select turned off: Rippling is disabled on these tracks.

Before and After, All tracks with Auto Select on are being rippled

Before and After, Track V1 is rippling, but tracks V2 and A2 are not because their Auto Select controls are off
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>> Tracks with Auto Select turned off with an edit selection: If you select the outgoing or 
incoming half of an edit on a track that has Auto Select off, the result will be a resize 
operation. Ripple deleting clips leaves a gap.

>> Tracks with Auto Select turned off: Rippling is disabled on these tracks.

>> Tracks with Auto Select turned off with an edit selection: If you select the outgoing or 
incoming half of an edit on a track that has Auto Select off, the result will be a resize 
operation. Ripple deleting clips leaves a gap.

Typically, you’ll want to leave Auto Select on for all tracks when rippling clips, to ensure that all clips 
in your timeline stay in sync. However, when the occasion requires, this gives you the option to 
suspend rippling on specific tracks while allowing rippling on others.

Before and After, Track V1 is rippling, but the selection on track V2 is being resized because its Auto Select control is off
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Trimming Multiple Edits or Clips at Once

DaVinci Resolve lets you select multiple edit points or clips for certain trimming operations, 
making it possible to trim multiple edits and clips at the same time. In simple cases, this makes 
it easy to resize, ripple, slip, and slide several superimposed clips at the same time, which is a real 
convenience. In more complicated cases, this lets you create more complicated trimming scenarios, 
such as multi-track asymmetric trimming, to quickly take care of difficult tasks.

No matter how ambitious a trim operation you want to set up, the procedure is exactly the same as for 
an ordinary trim operation. Just make sure you follow these three general steps, and you’ll be good:

1.	 Choose Selection mode, and select the edit points or clips you want to trim. To make multiple 
selections, click once to select the first item, then Command-click each subsequent item 
you want to add to the selection. When making multiple selections for trim operations, the 
following rules apply:

>>When selecting multiple edit points: You can only select one edit point per track.

>>When selecting multiple clips: You can select as many clips as you like on any combination 
of tracks.

2.	 To ripple, slip, or slide each selected item at once, choose Trim mode. To resize or move each 
selected item at once, continue using Selection mode.

3.	 Use the mouse or keyboard shortcuts to execute the trimming operation, just as you would if 
a single item were selected.

The following sections describe each of the special-case multi-selection trim operations that are 
possible, along with each one’s special rules and limitations.

Resizing, Rippling, and Rolling Multiple Edit Points

You can resize, ripple, or roll multiple edit selections at once, up to one selection per track. In this 
way, you can adjust the edit points of multiple superimposed clips all together. Trimming multiple 
edit points essentially lets you “gang” them so that they all move together.

To resize or ripple multiple clips at once, select multiple edit points (only one per track), then use 
the Selection tool to drag those edit points to resize at the same time, or use the Trim tool to ripple 
all clips at the same time.

Note: You cannot combine ripple and roll operations at the same time.
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Asymmetric Trimming

Asymmetric resize or ripple trimming can also be done to multiple clips, with one selection per 
track allowable on as many tracks as you require. To asymmetrically trim two or more clips, select 
an outgoing edit point on one track, and then Command-click an incoming edit on another track.

To select the outgoing video edit of one clips and the incoming audio edit of the next clip in 
preparation for making a split edit, you can Option-click the outgoing video edit to suspend linked 
selection, and then Command-click the incoming audio edit to add it individually to the selection. 
Now when you drag, nudge, or use timecode to trim, each selected edit point will move in the 
opposite direction.

Asymmetric trimming can be done in either Selection or Trim mode, either to open and close gaps, 
or to move edit points to overlap one another to create split edits.

Selecting opposite outgoing and incoming edit points in preparation for making an asymmetric trim

Dragging to perform an asymmetric trim to create a split edit in Trim mode
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Slipping Multiple Clips

You can simultaneously slip any number of selected clips (so long as they have handles) on any 
combination of tracks by selecting the clips you want to slip, then choosing the Trim tool, and 
dragging their name bars or using the comma and period keys to nudge the selection.

Sliding Multiple Clips

You cannot currently slide multiple clips at once.

Keyboard Trimming During Looped Playback

A great technique for editors who like to do precision trimming using the Nudge tool is the ability to 
enable looped-playback so that the Play Around command (Forward Slash) will loop continuously 
around the edit point you’re trimming as you nudge one or ten frames at a time to fine tune the cut.

To trim while looping:

1.	 Move the playhead near the edit point you want to trim, and press V to select it.

2.	 Press the U to choose which side of the edit you want to select in order to ripple or roll it, 
and/or Option-U to choose whether you want to trim video+audio, the video only, or the 
audio only.

3.	 Press Command-Forward Slash (/) to enable looped playback.

4.	 Press Forward Slash (/) to play around the current edit. With looping on, playback will continue 
until you stop it. Pre-roll and post-roll can be changed in the Edit panel of the Project Settings.

5.	 During looped playback, press the comma (,) and period (.) keys to trim the selection back 
or forward by a single frame, or Shift-comma and Shift-period to trim the selection in 10 
frame increments.

6.	 When you’re finished, press the Space Bar or K key to stop playback.

Dragging to slip multiple selected clips at once
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Dynamic Trimming Using Command-JKL

One of DaVinci Resolve’s most exciting trimming features is the ability to dynamically resize, ripple, 
roll, slip, slide, or move selected edit points and clips using Command-JKL. This means that you 
can trim during playback, by making an appropriate selection in the Timeline (edit points to resize, 
ripple or roll, or clips to slip or slide) and then holding the Command key down while using the JKL 
keyboard shortcuts. 

Trimming while viewing the current clip playing back has the advantage of letting you get emotionally 
involved in what you’re watching, as well as experiencing the timing of a clip as it plays, in order to 
help you get a better feel for how, exactly, you need to trim a particular shot. Additionally, you have 
the option of using Command-JKL to trim at different speeds if you have a long trim operation and 
you’re feeling impatient.

While you’re dynamically trimming, you see the same two-up or four-up display, the same Timeline 
overlays, and the same dynamically updating Timeline that appear when you use the trim tool with 
the mouse. The only difference is that everything happens while your program plays.

>> To dynamically roll an edit: In either Selection or Trim mode, select the center of one or 
more edit points (one per track), and hold the Command key down while using JKL to move 
the selection around.

>> To dynamically ripple an edit: Choose Trim mode, select the outgoing or incoming half of 
one or more edit points (one per track), and hold the Command key down while using JKL 
to move the selection around.

>> To dynamically resize an edit: Choose Selection mode, select the outgoing or incoming half 
of one or more edit points (one per track), and hold the Command key down while using 
JKL to move the selection around.

>> To dynamically move a clip: Choose Selection mode, select one or more clips, and hold the 
Command key down while using JKL to move the selection around.

>> To dynamically slip or slide a clip: Choose Trim mode, select one or more clips to slip, or a 
single clip to slide, press S to toggle between Slip or Slide modes, then hold the Command 
key down while using JKL to execute either slip or slide operations.

Note: When you’re finished with a dynamic trim operation and you want to see how that edit plays, 
you can use press the Forward Slash key (/) to play around the position of the playhead to quickly 
preview that section of the Timeline.
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Trim Start and Trim End

Trim Start (Option-[) and Trim End (Option-]) let you resize the In or Out point of all clips that intersect 
the playhead as either a ripple operation (in Trim mode) or a resize operation (in Selection mode). 
You do not need to make a selection to use Trim Start and Trim End, making these commands fast 
to use in the right situation. A classic use of Trim End is when you have several superimposed clips 
of different lengths that you want to either start or end at the same time.

>> Trim Start resizes intersecting clips so that each clip’s In point is moved to the current 
playhead position. 

Trim End resizes intersecting clips so that each clip’s Out point is moved to the current 
playhead position.

You can exclude clips on specific tracks from this operation by disabling the auto-select controls on 
those tracks.

Before and After a Trim Start operation

Before and After a Trim End operation



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

304

EDIT6

Extend Edits

The Extend Edit command lets you resize or ripple one or more selected edit points. Unlike Trim 
Start and Trim End, it doesn’t matter if the playhead intersects clips when doing an Extend edit. 
Make one selection per track of any combination of In or Out points, and press the E key to move 
those edit points to the current position of the playhead. 

In Trim mode, selected edit points will ripple instead of resizing affected clips. However, to simplify 
multi-track extend edit operations when using the Trim tool, the lowest numbered video track with 
auto-select enabled defines the track on which the extend edit performed will ripple the rest of the 
Timeline; all selected edit points on other tracks are simply resized.

Before and After a multi-track extend edit performed in selection mode

Before and After a multi-track extend edit performed in Trim mode shows that the lowest numbered track with a selection 

defines how the Timeline is rippled
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As you work in the Timeline, you’ll find there are times when you want to disable clips that you 
don’t want to appear during playback, without actually removing them from the edit. For example, 
you may decide to disable superimposed clips that are positioned as insert shots in the middle of 
a scene because of a client’s notes, but you don’t want to eliminate the clips because they might 
change their minds.

In another example, you’ve edited a series of titles on track V3, but you need to disable track V4 in 
order to output a textless version of the movie as a deliverable.

When a clip or track is disabled, it appears dimmed, and the disabled clips don’t appear in the Color 
page, and aren’t output to tape or rendered to disk in the Deliver page unless re-enabled first. 

To disable/enable one or more clips in the Timeline:

>> Select one or more clips, then right-click the selection and check or uncheck Clip Enable in 
the contextual menu, or press D to toggle a clip’s enabled state. 

To disable/enable an entire track:

>> Click the track enable button.

A disabled clip on track V2

Track V3 is disabled, making the Timeline textless as a result

Enabling and Disabling Clips and Tracks
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Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions of a 
particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes where you or 
the client can’t quite decide which one is the best, or for maintaining multiple versions of VFX clips 
that are going through different iterations. 

When you place a number of clips inside a Take Selector, only one clip appears in the Timeline, but 
you can open that Take Selector and switch to any other take or version that’s stored within to switch 
which clip appears in the Timeline whenever you want.

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips 
inside the Take Selector, you can slip each clip’s range of media, or choose a new clip to appear in 
the Timeline, before closing the Take Selector. 

When closed, multi-take clips can be edited, trimmed, graded, and rendered like any other clip in 
the Timeline. A Take Selector badge appears to the left of the name of a clip to which it’s applied to 
show its status; double-clicking this badge opens the Take Selector so you can adjust its contents.

Methods of using Take Selectors:

>> To create a Take Selector: Right-click any clip that’s not a Title or Generator, and choose 
Take Selector from the contextual menu. The Take Selector interface appears, disabling 
the rest of the Timeline temporarily while you work with the Take Selector’s contents.

Using Take Selectors

A Take Selector, shown open, with several alternate takes placed within

When closed, a Take Selector appears as a regular clip with a badge
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>> To populate a Take Selector: Drag any clip from the Media Pool into the Take Selector, and 
it appears “stacked” on top of the original clip in the Timeline.

>> To choose the current clip: Click any clip so that it’s highlighted in blue, and click the close 
button at the upper-left corner of the Take Selector. When next you open the Take Selector, 
the current clip appears at the bottom of the stack, with a star at the upper-left corner.

>> To set a take selector to ripple the timeline when a longer or shorter take is selected: Click 
the Ripple Take button, at the upper right-hand corner of the Take Selector panel, to the 
left of the trash can button.

>> To slip a clip within the Take Selector: Drag any clip to the left or right to slip the range of 
media that appears within the Take Selector’s duration in the Timeline.

>> To remove a clip from a Take Selector: Click the clip you want to remove to select it, then 
click the garbage can button at the upper-right corner of the Take Selector.

>> To close a Take Selector: Click the X close button.

>> To reopen a Take Selector: Double-click the Take Selector badge at the left of a clip’s name, 
or right-click a multi-take clip and choose Take Selector from the contextual menu.

>> To eliminate a Take Selector: Close the Take Selector, if open, then right-click that clip in the 
Timeline and choose Finalize Take from the contextual menu.
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DaVinci Resolve has several methods of locating clips, markers, and gaps, to help you troubleshoot 
problem timelines, or to find media that you want to edit into a timeline differently.

Methods of finding clips:

>> To locate a clip in the Edit Index via the Timeline: Move the Timeline playhead to intersect 
a clip you want to find in the Edit Index. That clip’s corresponding event (or events if the 
playhead intersects multiple clips) are automatically highlighted in the Edit Index.

>> To locate a clip in the Timeline via the Edit Index: Click an event in the Edit Index and the 
Timeline playhead will automatically move to the In point of that clip.

>> To find a clip in the Timeline: Open the Edit Index, choose a criteria from the Search Options 
pop-up menu, and then type a search term in the Search field at the top right of the Edit 
Index. As soon as you start typing, all edit events that don’t match the search criteria are 
temporarily hidden. To show all of the clips in the Edit Index again, click the cancel button 
at the right of the search field.

>> To find a clip in the Media Pool: Open the Media Pool, if necessary. Then choose a criteria 
from the Search Options pop-up menu, and type a search term in the Search field at the 
top right of the Edit Index. As soon as you start typing, all clips that don’t match the search 
criteria are temporarily hidden.

>> To locate a Timeline clip in the Media Pool: Right-click any clip in the Timeline, and choose 
Find in Media Pool. That clip appears highlighted in the Media Pool. 

>> To locate a Source Viewer clip in the Media Pool: With any clip open in the Source Viewer, 
press Option-F.

>> To locate a media file in the Finder from the Media Pool: Right-click any clip in the Media 
Pool and choose Reveal in Finder. A Finder window, or its equivalent in Windows and Linux, 
opens to the directory with that clip, which appears highlighted.

>> To locate offline media in the current Timeline via the Edit Index: Click the Option menu of 
the Edit Index and choose Show Offline Clips. Each offline clip appears in a list, and you can 
click any item on the list to jump the playhead to that particular clip in the Timeline.

If you’re using markers to keep track of notes, issues, or items on your to-do list, there are a few 
different ways of finding and moving among them.

Methods of finding Markers:

>> To find all markers via the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers. Each clip with one or more markers appears in a list, with columns 
corresponding to the color(s) and notes of each timeline and clip marker.

>> To move the playhead to the next marker forward or previous: Choose Playback > Previous 
Marker (Shift-Up Arrow) or Next Marker (Shift-Down Arrow).

Finding Media, Markers, and Gaps
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You can select a series of clips in the Timeline, whether they are edited one after the other in serial 
or superimposed and stacked in parallel, and turn them into a Compound Clip, which is a single clip 
in the Timeline that’s actually comprised of many other audio and video clips embedded inside. 
This allows you to work with a block of clips as if it were a single unit, governed by a single set of 
Inspector controls, and able to be connected to another clip in your timeline by a single transition.

Editing a compound clip works the same as editing any other type of clip. They can be edited, 
trimmed, and deleted using all the same methods. In addition, compound clips can be renamed, 
and decomposed back into their component clips right in the Timeline.

To create a compound clip:

1.	 Select a range of clips.

2.	 Right-click one of the selected clips and choose New Compound Clip.

3.	 Enter a name and optional start timecode for the compound clip you want to create, and 
click Create.

	 A compound clip is created which takes the place of the original clips you selected on the 
Timeline. Additionally, a copy of that compound clip appears in the currently selected folder 
of the Media Pool.

Compound Clips

Selecting a range of clips to turn into a compound clip

The resulting compound clip
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To rename a compound clip:

1.	 If the Media Pool is in List view, click the name of a compound clip in the Media Pool to select 
the clip and highlight the Name column. If the Media Pool is in Thumbnail view, then just select 
the compound clip you want to edit.

2.	 Press the Return key to select the name of the compound clip.

3.	 Type a new name, and press the Return key to accept the change. 

To edit a compound clip:

1.	 Right-click any compound clip and choose Open in Timeline from the contextual menu. 

	 The Timeline updates with the contents of the compound clip, which you can re-edit at your 
discretion. 

2.	 To return to the original Timeline when you’re finished, click the close button in the compound 
clip item under the Timeline.

To decompose a compound clip into its individual clips:

>> Right-click any compound clip and choose Decompose in Place from the contextual menu. 
The compound clip is replaced by the individual clips it was made from.

Closing the compound clip
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Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively 
long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where 
multiple takes are all recorded within a single clip, you can break these takes up by making them 
into subclips.

To create a subclip:

1.	 Double-click any clip in the Media Pool to open it into the Source Viewer.

2.	 Set In and Out points to define the section you want to turn into a subclip.

3.	 Right-click the jog bar and choose Make Subclip from the contextual menu. 

	 A new subclip appears in the Media Pool, automatically selected so that you can immediately 
edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in Resolve. You can also create subclips 
in the Media page while performing other organizational tasks there.
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Transitions provide another way of bridging the change from one clip to another, and are often used 
to indicate a change in time or location when changing scenes. DaVinci Resolve supports a variety 
of transitions ranging from various forms of the traditional cross-dissolve to different types of wipes, 
allowing for great flexibility when finishing creative edits. In addition, Resolve supports third-party 
OpenFX transitions that you install on your system. Transitions are applied at edit points, and 
appear as editable objects in the Timeline.

A transition in the Timeline

The default transitions that come with DaVinci Resolve appear within the Toolbox panel of the 
Effects Library, while OpenFX transitions appear within the OpenFX panel.

Adding and Editing Transitions

The following procedures describe how to work with transitions in the Timeline.

Methods of working with transitions:

>> To add a transition by dragging it from the Effects Library: Drag a video transition from the 
Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at 
the edit point. If there is no overlap between the heads and tails of the two clips, you may 
not be able to add a transition where you want.

>> To add a transition using the Effects Library contextual menu: Select one or more edit 
points (one per track), then right-click a video transition in the Effects Library and choose 
Add to Selected Edit Points.

>> To add a transition using the mouse: Right-click any edit point between clips with 
overlapping handles, and choose one of the four durations available for the Standard 
Transition; the available choices are quarter-second, half-second, one second, and two 
seconds, expressed in frames at whatever the current frame rate of the Timeline is.

Working With Transitions
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>> To add a transition using the keyboard: Using the Selection tool, select one or more edit 
points (as many as you like on any combination of tracks), and press Command-T to add 
the standard transition for either one second, or as long as there are overlapping handles 
available.

>> To add a transition with specific alignment using the keyboard: Select an edit, press the U 
key to choose the start, center, or end of the edit, then press Command-T. The standard 
transition will be added with its alignment based on the edit selection; selecting the start 
of the edit places a transition that ends on the edit; selecting the end of the edit places a 
transition that starts on the edit, and choosing the center of the edit places a transition that 
is similarly centered.

Methods of altering transitions in the Timeline:

>> To change a transition’s type: Drag a different transition from the Effects Library onto the 
current one in the Timeline.

>> To change a transition’s duration: Drag the beginning or end of the transition in the Timeline 
to be longer or shorter symmetrically about the current edit. Alternately, you can double-
click any transition to open it in the Inspector, and set a new duration in seconds or frames.

>> To change a transition’s alignment: Right-click a transition in the Timeline and choose a 
new method of alignment from the contextual menu. Alternately, you can double-click any 
transition to open it in the Inspector, and choose a new option from the Alignment pop-up.

>> To remove a transition: Select a transition in the Timeline and press the Delete key.  
Or, right-click a transition in the Timeline and choose Delete from the contextual menu.

Transition Properties in the Inspector

Double-clicking a transition in the Timeline opens that transition’s properties in the inspector. Each 
transition has the following properties you can edit.

>> Duration: The duration of the transition, shown in both seconds and frames.

>> Alignment: A pop-up that lets you choose the transition’s position relative to the edit point 
it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

>> Transition style: A pop-up that lets you change the type of transition; you can choose from 
among all of the transitions that come with DaVinci Resolve by default.

Additional properties that are specific to each type of transition appear in another group below. 
Since the Cross Dissolve transition is the most common transition used, its properties will be shown 
as an example.

>> Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, etcetera) expose 
this pop-up that lets you choose different ways for the outgoing clip to blend into the 
incoming clip during the dissolve. There are six different options to choose from:
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>> Video: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.

>> Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

>> Additive: The outgoing and incoming clips are cross faded using the Additive 
composite mode. As a result, the transition seems to brighten at the halfway point.

>> Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

>> Highlights: The outgoing and incoming clips are cross faded using the Lighten 
composite mode. The lightest parts of each clip are emphasized during this transition.

>> Shadows: The outgoing and incoming clips are cross faded using the Darken composite 
mode. The darkest parts of each clip are emphasized during this transition.

>> Start Ratio: Defines the percentage of completion for the transition at its first frame, from 0 
to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately 
appearing at a more fully cross-dissolved state from the very first frame.

>> End Ratio: Defines the percentage of completion for the transition at its last frame. Setting 
the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming 
shot at its last frame.

>> Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

>> Ease: A pop-up that lets you apply non-linear acceleration to the beginning, ending, 
or overall duration of a transition. The result is to add inertia to the transition from the 
outgoing clip to the incoming clip, and providing a gentler change from each clip into and 
out of the transition.

>> In: The outgoing clip lingers as the beginning of the transition dissolves more slowly 
than the end.

>>Out: The outgoing clip fades away more quickly, as the beginning of the transition 
dissolves more quickly than the end.

>> In & Out: Both the outgoing and incoming clips make slower transitions at the beginning 
and end of the dissolve, but the very center of the transition is faster as a result.

Other types of transitions display other properties, which are described at length in the 
following section.
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DaVinci Resolve Transitions

The following are transitions that are available within Resolve by default, along with the parameters 
that are available from the Inspector:

>> Cross Fade: An audio-only transition that lets you fade 

>> Cross Dissolve: Start Ratio lets you adjust how far along the transition is when it first begins, 
from the very beginning of the transition to 50 percent through the transition. End Ratio lets 
you adjust how far the transition gets at the very end, from a complete transition through 
50 percent of the transition. The Reverse checkbox reverses the direction of the transition.

>> Additive Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition.

>> Dip to Color Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition. Color lets you choose what color the dissolve dips to at the midpoint.

>> Center Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
emerges from the middle of the screen.

>> Clock Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Angle specifies the starting angle of the wipe 
as it spins around the center of the screen. The Clockwise checkbox sets the direction of 
the clock wipe.

>> Edge Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
moves across the screen.

>> Venetian Blind Wipe: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Repeat specifies how many “blinds” 
appear within the wipe effect. Angle specifies the angle of this multi-wipe effect.

>> Cross Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the cross wipe begins, as X and Y coordinates on the screen.
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>> Diamond Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the diamond-shaped wipe begins, as X and Y coordinates on the screen.

>>Oval Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which this circular wipe begins, as X and Y coordinates on the screen. Oval Ratio changes 
the aspect ratio of the oval, making it either wider or taller.

>> 5 Star: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Offset to Center identifies the center point at which this 
circular wipe begins, as X and Y coordinates on the screen. Feather blurs the border.

>> Box: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Box mode lets you choose one of the following options:

>> Upper Left

>> Upper Right

>> Lower Left

>> Lower Right

>> Left Center

>> Top Center

>> Right Center

>> Bottom Center

>> Heart: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Offset to Center identifies the center point at which this 
circular wipe begins, as X and Y coordinates on the screen. Feather blurs the border.

>> Triangle Left: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather lets you blur the edge of the transition 
from the outgoing to the incoming clip.

>> Triangle Right: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather lets you blur the edge of the transition 
from the outgoing to the incoming clip.

OpenFX Transitions

If you’ve installed one or more sets of OpenFX plugins on your DaVinci Resolve workstation, any 
transitions within those sets will appear in the OpenFX panel of the Effects Library.
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Organizing Transitions and Setting the Standard Transition

While DaVinci Resolve provides 24 transitions by default, most editors typically only use a subset of 
these in their day-to-day work. Furthermore, different projects may require different transitions be 
used as the Standard Transition. Resolve gives you several tools for dealing with this.

Methods of setting and filtering favorites in the Effects Library:

>> To set a transition or other effect as a favorite in the Effects Library: Right-click any transition 
or effect and choose “Add to Favorites.” Favorite transitions and effects appear with a star 
at the upper left-hand corner.

>> To display only your favorites in the Effects Library: Click the options menu at the upper 
right-hand corner of the Effects Library, and choose Favorites.

>> To display all effects in the Effects Library: Click the options menu at the upper right-hand 
corner of the Effects Library, and choose Favorites again so that it’s unchecked.

To change the Standard Transition:

>> Right-click any transition or effect and choose “Set as Standard Transition.”


